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Disclaimer 
Thunderhead Engineering makes no warranty, expressed or implied, to users of PyroSim, and accepts no 

responsibility for its use. Users of PyroSim assume sole responsibility under Federal law for determining 

the appropriateness of its use in any particular application, for any conclusions drawn from the results of 

its use, and for any actions taken or not taken as a result of analyses performed using these tools. 

Users are warned that PyroSim is intended for use only by those competent in the fields of fluid 

dynamics, thermodynamics, combustion, and heat transfer, and is intended only to supplement the 

informed judgment of the qualified user. The software package is a computer model that may or may 

not have predictive capability when applied to a specific set of factual circumstances. Lack of accurate 

predictions by the model could lead to erroneous conclusions with regard to fire safety. All results 

should be evaluated by an informed user. 

Throughout this document, the mention of computer hardware or commercial software does not 

constitute endorsement by Thunderhead Engineering, nor does it indicate that the products are 

necessarily those best suited for the intended purpose.
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Chapter 1. Getting Started 

Introduction 
PyroSim is a graphical user interface for the Fire Dynamics Simulator (FDS).  FDS models can predict 

smoke, temperature, carbon monoxide, and other substances during fires. The results of these 

simulations have been used to ensure the safety of buildings before construction, evaluate safety 

options of existing buildings, reconstruct fires for post-accident investigation, and assist in firefighter 

training. 

FDS is a powerful fire simulator which was developed at the National Institute of Standards and 

Technology (NIST) (McGrattan, et al., 2007).  FDS simulates fire scenarios using computational fluid 

dynamics (CFD) optimized for low-speed, thermally-driven flow.  This approach is very flexible and can 

be applied to fires ranging from stove-tops to oil storage tanks.  It can also model situations that do not 

include a fire, such as ventilation in buildings.  FDS and the Smokeview visualization program are both 

closely integrated into PyroSim. 

The PyroSim interface provides immediate input feedback and ensures the correct format for the FDS 

input file.  You can work in either metric or English units and you can switch between the two at any 

time.  In addition, PyroSim offers high-level 2D and 3D geometry creation features, such as diagonal 

walls, background images for sketching, object grouping, flexible display options, as well as copying and 

replication of obstructions (0). You can import DXF files that include either 3D faces or 2D lines that can 

be extruded to create 3D objects in PyroSim (Chapter 3). 

The PyroSim interface, for which this manual is written, supports Version 5 of the Fire Dynamics 

Simulator. PyroSim 2006, which supports Version 4 of the Fire Dynamics Simulator, is still available upon 

request. 

Download and Install 
The current version of PyroSim is available on the web at http://www.pyrosim.com. Licensed users have 

access to a direct download page. Other users can download PyroSim by requesting a free trial. There is 

no difference between the trial version of PyroSim and the full version. Any restrictions imposed by the 

trial version are based on the license. 

When installing PyroSim, the installer will either upgrade an existing version or install PyroSim to a new 

location. This behavior is based on the version. When installing a minor update (e.g. upgrading from 

PyroSim 2008.1 to PyroSim 2008.2), the older installation will be removed and replaced with the new 

version. When installing a major update (e.g. PyroSim 2008.1 to PyroSim 2010.2), the older version will 

not be modified and the newer version will be installed to a different folder. Versions of PyroSim after 

PyroSim 2006 include their major version number in the install folder to make the difference between 

installed versions clear. 

http://www.pyrosim.com/
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Administrator privileges are required to install PyroSim. The installer needs to add processes to the 

operating system for license management and parallel FDS simulation. 

Using a Different FDS Executable 
Each PyroSim release comes bundled with FDS. A particular PyroSim release is designed and tested 

against the bundled version of FDS, but can be used to run any version of FDS. However, PyroSim will 

generate an input file based on the bundled version of FDS and it is important to understand differences 

in input format between the FDS versions before customizing PyroSim's FDS version. 

To change the version of FDS used by PyroSim: 

1. Download and install a new version of FDS from NIST. 

2. On the File menu, click Preferences.... 

3. Click on the appropriate Folder icon in the FDS Execution section to select the executable you 

want PyroSim to use. 

4. Click OK to close the Preferences dialog. 

Purchase PyroSim 
To enable PyroSim beyond the 30 day trial, you must purchase a license. A full list of purchasing options 

can be found at the PyroSim web site. 

Online Purchase 

You can purchase PyroSim online with our secure order form at: 

https://www.thunderheadeng.com/php/buy.php 

The order form is encrypted and Thunderhead Engineering will not retain your credit card number.  

Once the online transaction has been processed you will receive an Activation Key. Follow the 

instructions below to activate your license. 

If you need to contact us, please refer to the Contact Us section later in this chapter. 

Phone Purchase 

Simply call Thunderhead and we will be happy to help you with the purchase. For contact information, 

please refer to the Contact Us section later in this chapter. 

License Activation 

When you purchase a license, you will receive an alphanumeric key that can be used to activate the 

software. You must enter this key in the Licensing and Activation dialog. To activate your license using 

Online Activation: 

1. Start PyroSim. If the installation of PyroSim is not currently licensed, the Licensing and 

Activation dialog will automatically appear and you can skip to step 3. 

2. On the Help menu, click License.... 

3. Select the Online Activation option. 

https://www.thunderheadeng.com/php/buy.php
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4. Enter your Registration Key into the Key box shown in Figure 1.1. 

5. Click the Activate button. 

 

Figure 1.1. Licensing and Activation Dialog 

Transferring a License 

To transfer your license to another computer: 

1. On the Help menu, click Remove License…. 

2. Click OK to permanently remove your license. 

3. A dialog indicating the license has been successfully removed will be displayed.  Copy the 

Confirmation code and contact Thunderhead for a replacement license for the next computer. 

PyroSim will exit when you close the Remove License dialog. 

Updating PyroSim 

To update your version of PyroSim, simply run the installer for the updated version. Your application 

files will be replaced and your license will remain intact. 

If you purchased a perpetual license for PyroSim and your maintenance period has expired, new 

versions of PyroSim will not function with your old license and it will be necessary to reinstall the old 

version of PyroSim or purchase an updated license. 

Installing a Floating License 
A floating (network) license allows multiple users to run PyroSim from a central server. The PyroSim 

License Manager is required for floating (network) licenses of PyroSim. The license manager maintains a 

pool of licenses that can be checked out from copies of PyroSim installed anywhere on the network. The 
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license manager must be installed onto one computer that will act as a server for the floating licenses. 

Multiple PyroSim installations can then be configured to use the floating license server. 

Install the Floating License Manager 

The Floating License Manager should be installed on the computer that will act as the server for the 

floating licenses. To install the PyroSim License Manager: 

1. Download the PyroSim License Manager installer (PyroSimLicenseMgr-setup.exe). This file can 

be downloaded from the PyroSim download page. 

2. Log in using an account with administrative privileges. 

3. Run the PyroSim License Manager installer. 

This will install the main license server (rlm.exe), a PyroSim-specific license server (theng.exe), and 

utilities for managing the server. To enable the floating license server, you must now install a license file. 

Install the License File 

To activate your floating license, you must install a license file. This license file is generated by 

Thunderhead Engineering based on your server's Host Name and Host ID. To find your Host Name and 

Host ID: 

1. On the Windows Start Menu, click All Programs/PyroSim License Manager/Server HostID. A 

command window will appear that displays the server's Host Name and Host ID, Figure 1.2. 

2. Send your Host Name and Host ID to Thunderhead Engineering (email 

sales@thunderheadeng.com). Also, include your purchasing information to help us know what 

kind of license you need. Thunderhead Engineering will reply with a license file (pyrosim.lic). 

3. Copy the license file (pyrosim.lic) to the license manager installation folder, typically C:\Program 

Files\PyroSim License Manager. 

4. On the Windows Start Menu, click All Programs/PyroSim License Manager/Restart License 

Service. You must be an administrator to restart the license service. On Windows Vista, right-

click the Restart License Service shortcut and select Run as administrator. 

 

Figure 1.2. Display of Host Name and Host ID 

Once the license service has been restarted, the license file will be loaded and the server is ready to 

provide PyroSim licenses to client computers. 
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Server Configuration 

You can check the status of the license server using the Server Status shortcut, which displays a short 

textual report of server usage, or through the Monitor License Server shortcut, which will displays a 

simple web interface. Both methods show how many licenses are in use and which users are currently 

using licenses. 

HOST aurora 4e7c365b 52100 

ISV theng theng.exe theng.opt 52101 

By default your license server uses TCP port 52100. If you are using a personal software firewall or 

accessing the server across a hardware firewall, you will have to configure the firewall to allow TCP 

traffic on ports 52100 and 52101. The ports used by the license manager can be configured in the 

license file by editing the port numbers on the HOST and ISV lines. After changing the port numbers in 

the license file, you must restart the server for the changes to take effect. Also, any PyroSim installations 

that were configured using the previous port assignments will need to be updated. 

There are several advanced options available to administrators to control the behavior of the license 

manager. The PyroSim License Manager is based on the Reprise License Manager (RLM). Please see the 

RLM End-User Documentation for advanced server administration. The RLM documentation can be 

found in the PyroSim License Manager installation folder. 

PyroSim Configuration on Local Computer 

Configure PyroSim to locate the floating license server using the Licensing and Activation dialog. 

To configure a PyroSim installation to use a floating license: 

1. Start PyroSim. If the installation of PyroSim is not currently licensed, the Licensing and 

Activation dialog will automatically appear and you can skip to step 3. 

2. On the Help menu, click License... 

3. Under Activation Method, click License Server. 

4. Click the ... button to the right of the Server box to edit the server name and port number. 

5. In the Server box, type your Host Name. 

6. In the Port box, type 52100 (or the number you specified in the license file). 

7. Click OK to save the server connection settings and attempt to connect to the license server. 



Getting Started 

 

6 

 

Figure 1.3. Select License Server in dialog 

 

Figure 1.4. Input Server and Port 

This completes the floating license configuration. This client will now check licenses in and out as 

needed. 

Note 

The default port number is 52100. If your configuration uses a custom port number on the HOST line of 

the server license file, use that port number instead. 

The license server location can also be set for the client using the pyrosim.props configuration file. Set 

the PyroSim.licenseServer property to port@host, where port is the port number of the license manager, 

and host is the server name. Using the server name "aurora" from our previous example, this line would 

be: 

PyroSim.licenseServer=52100@aurora 

Property names in the pyrosim.props file are case sensitive, so the property name must be entered 

exactly as shown. 
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Additional FDS and Smokeview Documentation 
In preparing this manual, we have liberally used descriptions from the FDS User's Guide (McGrattan, et 

al., 2007).  The FDS Users Guide, the FDS Technical Reference, and the Smokeview Users Guide have 

been included with PyroSim.  Updated documentation and executables for FDS and Smokeview may be 

available at: http://fire.nist.gov/fds/. 

System Requirements 
PyroSim runs on the Microsoft Windows operating system.  You should have at least 256 MB of system 

RAM, and a graphics card that supports OpenGL 1.1 or later. If you want to perform realistic simulations, 

we recommend 2 GB of system RAM, a graphics card with at least 128 MB of graphics memory, and a 

dual or quad core. PyroSim transparently supports parallel processing on multi-core/multi-processor 

computers. 

Contact Us 
Thunderhead Engineering 

403 Poyntz Avenue, Suite B 

Manhattan, KS 66502-6081 

USA 

Sales Information: sales@thunderheadeng.com 

Product Support: support@thunderheadeng.com 

Phone: +1.202.709.8511

http://fire.nist.gov/fds/
mailto:sales@thunderheadeng.com
mailto:support@thunderheadeng.com
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Chapter 2. PyroSim Basics 

PyroSim Interface 
PyroSim provides four editors for your fire model: the 3D View, 2D View, Navigation View, and the 

Record View. These all represent your current model. If an object is added, removed, or selected in one 

view, the other views will simultaneously reflect the change. Each view is briefly described below. 

• Navigation View: This view lists many of the important records in the model. It allows you to 

organize your model geometry into groups such as room or sofa. Locating and modifying records 

is often faster and easier in this view. 

• 3D View: This view shows a 3D representation of your current fire model. You can explore the 

model using different view controls. You can also control the appearance of the model with 

options like smooth shading, textures, and object outlines. Geometric features can also be 

changed. 

• 2D View: This view is useful for quickly sketching geometry such as walls and furniture. You can 

choose from three viewing planes and perform many useful geometric manipulations.  

• Record View: This view gives a preview of the FDS input file that will be generated for the 

simulation. It also provides a way to add custom records that will not be processed by PyroSim, 

but will be sent to FDS. 

Navigation View 
The navigation view is a tree-like view on the left side of the PyroSim main window. An example of this 

view in use is shown in Figure 2.1. When you right-click on an item in this view, a list of the functions 

PyroSim can perform on that item is shown. To rearrange objects in the Navigation view, make a 

selection and then drag the object(s) to the new location. 
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Figure 2.1. Using the context menu in the Navigation View 

3D View 
Use the 3D view to rapidly obtain a visual image of the model and perform some drafting. In this view, 

the user can navigate through the model in 3D and select objects. This view also provides display filters 

to quickly show/hide entire categories of objects or switch between floors. In addition, any drafting that 

requires objects to be snapped to faces of other objects, such as drawing a vent on an obstruction or 

attaching a measuring device to a solid can be easily achieved in this view. For more information on 

drafting, see Chapter 8. 

Navigation/Selection 

There are several tools that can be used to navigate the model and select objects.  The tools for the 3D 

view are found in the navigation toolbar above the 3D view as shown in Figure 2.2. 

 

Figure 2.2. 3D navigation toolbar 

 Select/Manipulate Tool ( ): This general-purpose tool can be used to perform most navigation 

activities.   

o Selection:  Left-click an object to select it.  Drag the left mouse button to draw a 

selection box and select all objects within the box. Double-click the left mouse button to 

select and open a properties dialog for the object under the cursor.  Hold ALT while 

performing selection to select the hierarchical parent of the object under the cursor.  

Right-click to show a context menu for selected items under the cursor. 

o Panning: Drag the middle mouse button to pan the model. 

o Orbiting: Drag the right mouse button to orbit the model. 
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o Manipulating: If a single object is selected, it may show manipulation handles (blue dots 

or faces).  Left-click one of the handles to begin manipulation or drag the left mouse 

button to perform manipulation in one gesture. For more information on manipulation, 

see Editing Objects on page 71. 

 Orbit Tool ( ): This is another general-purpose tool that may be more familiar to existing 

PyroSim users, but it is more limited than the Select/Manipulate Tool.   

o Selection: This is the same as with the Select/Manipulate Tool except that a selection 

box cannot be drawn. 

o Orbiting: Drag any mouse button to orbit. 

o Panning:  Hold the SHIFT key down while dragging any mouse button to pan. 

o Zooming: Hold the ALT key down while dragging any mouse button to zoom. 

o Manipulating: This tool cannot perform manipulation. 

 Roam Tool ( ): This tool allows the user to move into the model rather than viewing it only 

from the outside as shown in Figure 2.4. This tool can take some experimentation, but once 

mastered, it can provide unique views of the model. 

o Selection:  This is the same as with the Orbit Tool. 

o Looking: Drag any mouse button to look around.  This pivots the camera about the 

camera’s location, similar to a first-person video game. 

o Moving: Hold the ALT key while dragging a mouse button to move the camera up and 

down along the Z axis.  Hold the CTRL key while dragging a mouse button to move the 

camera forward, backward, and side-to-side in the camera’s XY plane. 

 Pan Tool ( ), Zoom Tool ( ), Zoom Box Tool ( ): These tools break out the functionality of 

the above tools so that dragging any mouse button will perform the needed action. 

 

Figure 2.3. Exterior view of model (PyroSim model by John McKinney) 
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Figure 2.4. Interior view of model looking at roof and bleachers 

Zooming 

The model can also be zoomed in and out with any of the navigation tools by using the scroll wheel.  

Scrolling up zooms in and scrolling down zooms out.  With all but the Roam Tool, using the scroll wheel 

will zoom in on the point under the cursor.  With the Roam Tool, the scroll wheel only zooms the center 

of the view. 

Resetting the View 

At any time, the camera’s view can be reset to see the entire extents of the model by clicking the Reset 

View button ( ) or pressing CTRL+r.  In addition, the camera can be reset to only the currently selected 

objects by clicking the Reset to Visible button ( ) or pressing CTRL+e.  Resetting the view also has the 

effect of changing the orbit center when orbiting. 

Orbiting 

Orbiting is the action of spinning the camera about its focal point, which is the center of the model or 

center of the selection, depending on which reset action was last performed.  By default, orbit works as 

if there is an invisible sphere around the model on which you click and drag the mouse to spin.  

Alternatively, orbiting can be performed similarly to Smokeview by going to the View menu and 

selecting, Use Smokeview-like Navigation.  In this mode the camera spins about the Z axis with left and 

right mouse movements and about the local X axis with up and down movements. 

Filtering 

There are several ways to filter the objects shown in the 3D view.  Filtering can be performed with 

clipping planes that are associated with floors or through filter buttons that can quickly show/hide 

categories of objects.   
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To use clipping, the user must first define floors for the model as discussed in Floors on page 48.  Once 

the floors are defined, a floor can be selected by using the Floor Drop-down above the 3D or 2D view as 

shown in Figure 2.5. 

 

Figure 2.5. Floors drop-down 

Once a floor has been selected, its clipping planes will be applied to the entire scene to only show 

objects within the clipping region. 

Filtering can also be performed using the filter toolbar buttons as shown in Figure 2.6.  

Selecting/deselecting these buttons will quickly show/hide all objects of a specific type, such as 

obstructions, holes, vents, etc. 

 

Figure 2.6. Filter toolbar 

Filtering can also be applied to meshes but in a slightly different way.  Instead of showing/hiding all 

meshes, the user can selectively show/hide three different elements of them using the mesh filter 

toolbar shown in Figure 2.7.  This toolbar selectively allows viewing mesh grid lines, mesh boundaries, 

and mesh outlines. Figure 2.8 shows the different mesh elements. In the figure, A shows the grid lines, B 

shows the boundary, and C shows the outline. 

 

Figure 2.7. Mesh filter toolbar 
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A B C 

Figure 2.8. Filtering mesh elements 

Background images attached to floors can be quickly shown/hidden using the Show Background Image 

filter button  next to the floor drop-down. 

2D View 
The 2D view is mostly the same as the 3D view with some key differences: 

 The 2D view provides pre-set, orthographic views of the model. The view can be set to the top 

, front , or side  views. 

 The 2D view does not have the Orbit and Roam tools.   

 The Select/Manipulate tool pans the model when dragging the right mouse button rather than 

orbiting. 

 Drafting is performed differently in the 2D View.  For more information, see 2D versus 3D 

Drawing on page 58. 

 Snapping can be performed to either the solution mesh or to a user-defined sketch grid. 

 When snapping to a solution mesh, the mesh grid lines are always shown, the boundary is never 

shown, and only the outline of the mesh can be optionally shown. 

 Floor clipping is slightly different.  For more information see Floors on page 48. 

Snapshots of Display 
Images of the current display can be saved to a file by opening the File menu and clicking Snapshot.... 

The user can specify the file name, image type (png, jpg, tif, bmp), and the resolution. A good choice for 

image type is Portable Network Graphics (png). 

Preferences 
PyroSim preferences can be set by going to the File menu and choosing Preferences.... Any changes to 

the preferences will be set for the current PyroSim session and be remembered the next time PyroSim is 

started. The preferences are split into several groups, including PyroSim, FDS, and Display preferences. 

PyroSim Preferences 

These describe global PyroSim preferences as shown in Figure 2.9. 
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Figure 2.9.  PyroSim Preferences 

Format FDS file for easy reading - controls the format of real numbers in the FDS input file created by 

PyroSim. When this is checked, a real number is written such that if the absolute value is >= .001 and < 

10000, it is written in decimal notation; otherwise, it is written in scientific notation. Max precision 

controls the number of significant digits written to the input file. 

• Autosave - instructs PyroSim to periodically create a backup of the current model that is deleted 

when the PyroSim model is closed. This backup is useful in case PyroSim crashes or the 

computer loses power. The default setting enables this feature and saves every 10 minutes. In 

some cases, when working with large models, this can cause unexpected delays during the save 

and some users prefer to disable the feature and save manually. 

• Create Backup on Open - controls whether PyroSim makes a backup of the PyroSim file after 

successfully opening it. This backup remains on disk when the file is closed, and so it can be used 

in case the main PyroSim file somehow becomes corrupted. NOTE: if this is enabled, PyroSim 

files may take slightly longer to load depending on how quickly the file can be copied to backup. 

• Record Preview - adds a preview pane to many of the dialogs in PyroSim. This preview pane 

shows the text that will be produced for the FDS input file. This can be helpful for users that 

want to understand exactly how PyroSim options correspond to FDS input. An example can be 

seen in Figure 2.10. 

• Show Splash Screen on Startup - controls whether the PyroSim splash screen is shown when 

starting PyroSim. 
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Figure 2.10. The materials dialog showing the FDS record preview pane 

FDS Preferences 

These preferences define the execution of FDS within PyroSim. They can be seen in Figure 2.11. 

 

Figure 2.11. FDS Preferences 

• Executable Locations - allow you to specify the FDS and Smokeview executables that are used 

by PyroSim. NOTE: PyroSim is designed to work with a specific version of FDS as noted below the 

executable locations. If you specify a different version, you may encounter unpredictable FDS 

results or errors. 
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• Auto-save PyroSim model before running FDS - controls whether PyroSim automatically saves 

the current PyroSim file just before beginning an FDS simulation. 

• Run Smokeview when FDS simulation completes - indicates whether to automatically launch 

Smokeview when an FDS simulation completes. 

• Parallel Simulations Use: - selects the FDS executable used when you click Run Parallel... on the 

FDS menu. The MPI option uses a separate process for each mesh in the simulation. The 

OpenMP option attempts to process loops in parallel and can improve performance on 

simulations that use one or many meshes. 

Display Preferences 

These preferences define advanced 2D and 3D display properties, as shown in Figure 2.12. They can be 

used to improve display performance on complex models, but they tend to create problems for some 

graphics cards, including crashing. For this reason, they are turned off when running in safe mode. 

 

Figure 2.12. Display Preferences 

• Hardware accelerated cursor - when checked, mouse crosshairs and object editing will remain 

smooth even on complex geometry that may be slow to pan or orbit. PyroSim does this by 

rendering the scene into an image buffer and then rendering that buffer as a texture 

underneath the crosshairs or editing geometry whenever the mouse cursor moves. 

• Hardware accelerated vertex buffers - when checked, this can significantly improve rendering 

performance of complex geometry. PyroSim does this by storing the geometry in vertex buffers 

on the graphics card. PyroSim then makes very few OpenGL calls to render the geometry. 

Units  
Models can be created in either English or Metric units. To select a system of units, on the View menu, 

click Units, then click the desired unit. PyroSim will automatically convert your previous input values into 

the unit system you select. The Record View will always display values in the appropriate FDS units, 

regardless of what unit system you choose to work in. 
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Color Schemes  
To select a Default, Black Background, White Background, or Custom color scheme, on the View menu, 

click Color Scheme. The custom color scheme is defined in the PyroSim.props file in the PyroSim 

installation directory (usually C:\Program Files\PyroSim). 

1. To define a custom color scheme: 

2. Close PyroSim 

3. Edit the PyroSim.props file 

4. Change the following default colors to the colors you wish: 

 

Colors.Custom.axis=0xffff00 

Colors.Custom.axis.box=0x404040 

Colors.Custom.axis.text=0xffffff 

Colors.Custom.background=0x0 

Colors.Custom.boundary.line=0xffffff 

Colors.Custom.grid=0x4d4d66 

Colors.Custom.group.highlight=0xffff00 

Colors.Custom.heatDetector=0xff0000 

Colors.Custom.obst=0xff0000 

Colors.Custom.obst.highlight=0xb2b200 

Colors.Custom.origin2D=0x737373 

Colors.Custom.smokeDetector=0xff00 

Colors.Custom.snap.point=0xff00 

Colors.Custom.snapto.grid=0x404040 

Colors.Custom.snapto.points=0xc0c0c0 

Colors.Custom.sprk=0xff 

Colors.Custom.text=0xffffff 

Colors.Custom.thcp=0xffff00 

Colors.Custom.tool=0xff00 

Colors.Custom.tool.guides=0x7c00 

 

5. Save the edited PyroSim.props file 

6. Restart PyroSim
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Chapter 3. Working with Files 
Several files are used when performing a fire analysis using PyroSim. These include the PyroSim model 

file, the FDS input file, and FDS output files. This section describes how to load and save files in the 

formats supported by PyroSim. 

Creating a New PyroSim Model 
When PyroSim is started, it begins with an empty model. You can close the current model and create a 

new empty model by opening the File menu and clicking New. PyroSim always has one (and only one) 

active model. 

Saving a PyroSim Model    
The PyroSim model file (PSM) is stored in a binary format that represents a PyroSim model. The PyroSim 

model contains all the information needed to write an FDS input file, as well as additional information 

such as obstruction grouping, floor heights, background images, and textures. This format is ideal for 

sharing your models with other PyroSim users. 

To save a new model: 

1. On the File menu, click Save. 

2. Enter the file name and click the Save button. 

Open a Saved PyroSim Model 
PyroSim model files have a PSM extension. To open a saved model: 

1. On the File menu, click Open.... 

2. Select the file and click the Open button. 

A list of recently opened files is also available. To open recent files, on the File menu, click Recent 

PyroSim Files, then click the desired file. 

PyroSim has an auto-save feature which stores a copy of your current model every 10 minutes. This file 

is automatically deleted if PyroSim exits normally, but if PyroSim crashes, you can recover your work by 

opening the autosave file. It can be found either in the same directory as your most recent PSM file, or 

in the PyroSim installation directory if your model was unsaved. 

For more information about opening files saved with previous versions of PyroSim, please refer to 

Chapter 21.Appendix A.  

Preventing Changes to a Model  
PyroSim supports write protection for a model. When write protection is enabled, users cannot modify a 

model (e.g. change geometry, edit surface properties, etc). This option can be enabled with or without 

password protection. If a model is write-protected, PyroSim will display notification in the application 

title bar. 
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To add write protection to a model: 

1. On the File menu, click Write Protection... 

2. Click OK. 

The model will now be write-protected. Since a password was not used, a password will not be required 

to remove write protection. 

To remove write protection from a model: 

1. On the File menu, click Write Protection... 

2. Click OK. 

The model can now be edited. If needed, the dialog will require a password to release the lock. 

Importing FDS Models    
PyroSim allows you to import existing FDS input files. When you import an FDS file, PyroSim will create a 

new PyroSim model from the imported file. During import, PyroSim will check for the validity of each 

record. If errors are detected, you will be notified. You may then make the required corrections and 

attempt to import the file again. 

To import existing FDS models into PyroSim: 

1. On the File menu, select Import FDS/CAD File… or click the Import button  on the main 

toolbar. 

2. Select the FDS file and click Open. 

PyroSim supports file import for versions 4 and 5 of FDS. For more information about opening files 

compatible with version 4 of FDS, please refer to Appendix A.  

Exporting FDS Models    
PyroSim also allows you to explicitly export the current model to an FDS input file. You can manually edit 

the file to take advantage of advanced FDS features, or to easily transfer the input file to a different 

machine or special version of FDS. 

To export an FDS file: 

1. On the File menu, click Export, then click FDS File... or click the Export button  on the main 

toolbar. 

2. Enter the file name and click Save. 

The file exported by PyroSim will be compatible with version 5 of FDS. 
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Importing CAD Files    
PyroSim allows users to import several types of CAD file formats, including the DXF and DWG format and 

the STL (Standard Tessellation Language) format.  Each type of file provides a variety of geometry that 

can either be directly represented as obstructions or as drawing guides in the PyroSim model. 

Unlike FDS import which completely replaces the current PyroSim model, CAD import appends the data 

to the current model.  This facilitates the ability to import data from several CAD files into one PyroSim 

model.  This is useful when there is one blueprint per floor of a building or a 3D building has been split 

into several sections, each in a separate file. 

DWG/DXF Import 

DWG and DXF files are standard drawing formats supported by a variety of CAD software including 

Autodesk’s AutoCAD and Revit software suites. These types of files can contain both 3D geometry, such 

as walls, slabs, solids, and faces and 2D geometry, such as circles, arcs, and lines. 

While versions of PyroSim earlier than 2012 required users to decompose some types of geometry (such 

as solids or architectural elements) in the source software, PyroSim 2012 and later fully support these 

formats and all types of geometry without decomposition. 

To import DXF or DWG files, perform the following: 

1. On the File menu, select Import FDS/CAD File… or click the Import button  on the main 

toolbar. 

2. Select the desired DXF or DWG file to import and click Open. 

3. Select the length unit from the Import Options dialog shown in Figure 3.1.  If the DXF/DWG file 

stored a length unit with the file, this will be selected by default. 

4. Click OK to begin import. 

 

Figure 3.1. DXF/DWG Import Options dialog 

In the Import Options dialog, the Model Bounds are shown to help the user choose the proper length 

unit if it is unknown.  The Model Bounds will change depending on which unit is chosen.  Depending on 

the size of the import file, the model bounds may not be shown until the user clicks Calculate.  In this 
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case, it may take several minutes to calculate the model bounds.  It may be more beneficial to simply 

import the model using the default unit or take a guess and then resize the model after import. 

When PyroSim imports a DWG/DXF file, it will treat all 3D face data as obstructions and all other data 

(lines, curves, etc.) as separate CAD data.  If an entity in the file contains both face and CAD data, the 

entity will be split into two entities so that CAD data can be easily deleted or hidden after import using 

the CAD filter button on the 3D/2D View toolbar (see Filtering on page 11). 

An object with CAD data can be snapped to while drawing in PyroSim but is not converted to any type of 

FDS geometry. 

An entity with face data will either be treated as a single, solid obstruction with some volume or as a 

collection of thin obstructions depending on the entity type in the DWG/DXF file.  These objects will be 

represented as FDS geometry.  The following entity types are treated as solids in PyroSim: 

 3D Solid 

 Mass Element 

 Mass Group 

 Roof 

 Slab1 

 Roof Slab 

 Stair 

 Wall1 

 Door 

 Window 

 Curtain Wall 

 Curtain Wall Unit 

 Curtain Wall Assembly 

 Structural Member 

All other entities containing faces, such as polygon meshes and polyface meshes are treated as 

collections of thin obstructions by PyroSim.  They cannot be reliably treated as solid since there is no 

guarantee that their faces form a closed and non-self-intersecting shell or that this would even be 

desired. 

Once the file is imported, PyroSim creates a hierarchy of groups and objects, such that there is one top 

group, named after the file.  On the next level, there is a group for every layer containing geometry.  

Under each layer group there are one or more objects representing the entities in the file.  The following 

illustrates the hierarchy as it would appear in the Navigation View: 

                                                           
1
 While PyroSim allows the user to draw walls and slabs, it will not convert DWG/DXF wall and slab entities to 

native walls and slabs, due to the complexity with which walls and slabs can be represented in the DWG/DXF file.  
They will instead be represented as collections of individual faces, representing one solid object. 
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 FileName 

o Layer1 

 Entity1 

 Entity2 

 … 

o Layer2 

 Entity3 

 Entity4 

 … 

o … 

If the DWG/DXF file contains a block insert and the block contains entities from multiple layers, the 

block insert is split into several PyroSim objects, one for each layer of the block’s originating entities.  If 

all the entities in the block are from the same layer, however, there will be one resulting PyroSim object 

that will belong to the group corresponding to the block’s entities’ layer rather than the block insert’s 

layer.  

STL Import 

PyroSim can also import objects from STL files, which are simply listings of triangles.  Usually, each STL 

file represents the shell of one 3D solid object.  To import an STL file, perform the following: 

1. On the File menu, select Import FDS/CAD File… or click the Import button  on the main 

toolbar. 

2. Select the desired STL file and click Open. 

3. Enter the import options in the STL Import Options dialog as shown in Figure 3.2. 

4. Click OK to begin import. 

 

Figure 3.2. STL Import Options dialog 

In the STL Import Options dialog, the following options can be specified: 
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• File Units – the units used to store the 3D coordinates in the STL file. 

• Vertex weld tolerance – a distance used to determine how far apart vertices must be to be 

considered separate. 

• Resulting Geometry Type – choose Obstruction to treat the resulting objects as obstructions 

and Hole to treat them as holes. 

• Surface – the surface to apply to the resulting obstructions if applicable. 

• Convert to solid obstructions – whether to treat the resulting objects as solid obstructions.  If 

this is unchecked, each resulting object will be a collection of thin obstructions. 

Because the STL file is simply a listing of triangles, there may be more than one object represented in 

the file.  PyroSim will use the vertex weld tolerance to detect triangle connectivity and determine if 

there are several, disconnected sets of faces in the file.  If there are, there will be one resulting PyroSim 

object per connected set of faces.   

In addition, if the solid option is enabled or the objects are being treated as holes, import will only 

succeed if each face set is detected as a closed shell by PyroSim. 

Working with Revit Architecture 

While PyroSim cannot directly import Autodesk Revit files (RVT), Revit can export to DWG, which can 

then be imported into PyroSim.  To export a DWG file in Revit Architecture 2012, perform the following: 

1. Open the desired RVT file within Revit Architecture. 

2. Click the Revit icon at the top left . 

3. Select Export->CAD Formats->DWG files. 

4. In the DWG Export dialog, click the … button in the Select Export Setup section. 

5. In the Modify DWG/DXF Export Setup dialog, select the Solids tab, and select ACIS solids.  This 

option allows PyroSim to import objects as solid obstructions rather than treating each exported 

face as a thin obstruction. 

6. Click OK to close the Modify DWG/DXF Export Setup dialog. 

7. In the DWG Export dialog, for Export, select <In session view/sheet set>. 

8. For Show in list, select Views in the Model. 

9. Click the Check None button, and then in the view table, select the check box for 3D View: 

{3D} (Other views may be chosen, but the DWG will only contain entities visible in the selected 

views). 

10. Click the Next… button and choose a file name for the DWG file. 

11. Click OK to create the DWG. 

The resulting DWG file can now be imported into PyroSim.
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Chapter 4. Meshes  

Working with Meshes 
All FDS calculations are performed within computational meshes. Every object in the simulation (e.g. 

obstructions and vents) must conform to the mesh. When an object’s location doesn’t exactly conform 

to a mesh, the object is automatically repositioned during the simulation. Any object that extends 

beyond the boundary of the physical domain is cut off at the boundary. There is no penalty for defining 

objects outside of the domain, but these objects do not appear in Smokeview. 

To achieve optimal simulation accuracy, it is important to use mesh cells that are approximately the 

same size in all three directions. 

FDS uses a Poisson solver based on Fast Fourier Transforms (FFTs). A side effect of this approach is that 

optimal mesh divisions are constrained to the form 2u 3v 5w, where u, v and w are integers. For example, 

64 = 26, 72 = 23 * 32, and 108 = 22 * 33 are good mesh dimensions. However, 37, 99 and 109 are not. In 

addition, using a prime number of cells along an axis may cause undesirable results. PyroSim warns 

when the number of divisions is not optimal. 

Uniform Meshes 
This example illustrates creating a multiple mesh model. To create the first mesh: 

1. On the Model menu, click Edit Meshes.... 

2. Click New. 

3. In the Max X box, type 5.0, in the Max Y box, type 1.0, and in the Max Z box, type 1.0. 

4. In the X Cells box, type 50, in the Y Cells box, type 10, and in the Z Cells box, type 10. 

5. Click OK. 
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Figure 4.1. Defining properties of the new mesh 

The 3D View will now display the resulting mesh. 

Nonuniform Meshes 
To create a second, nonuniform mesh: 

1. On the Model menu, click Edit Meshes.... 

2. Click New 

3. In the Min X box, type 0.0, in the Min Y box, type 1.0, and in the Min Z box, type 0.0 

4. In the Max X box, type 1.0, in the Max Y box, type 3.0, and in the Max Z box, type 1.0 

5. In the Division method box, select Non-Uniform 

6. In the table, enter the data shown in Table 4.1 

7. Click OK 

Table 4.1. Non-Uniform Mesh Parameters 

Dir (X,Y,Z) Num Cells Size 

X 10 0.1 

Y 10 0.1 

Y 5 0.2 

Z 10 0.1 
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Figure 4.2. Defining properties of the nonuniform mesh 

You can click  (or type Ctrl + R) to reset the model. The resulting meshes are displayed below. 

 

Figure 4.3. 3D display of first and second mesh 

Using Multiple Meshes 
The term “multiple meshes” means that the computational domain consists of more than one 

rectangular mesh, usually connected, although this is not required. In each mesh, the governing 
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equations can be solved with a time step based on the flow speed within that particular mesh. Some 

reasons for using multiple meshes include: 

• Multiple meshes are required for parallel processing of FDS using the MPI option. 

• If the geometry of the problem has corridors such as shown in Figure 4.3, using multiple meshes 

can significantly reduce the number of cells and the solution time. 

• Because each mesh can have different time steps, this technique can save CPU time by requiring 

relatively coarse meshes to be updated only when necessary. Coarse meshes are best used in 

regions where temporal and spatial gradients of key quantities are small or unimportant. 

Meshes can overlap, abut, or not touch at all. In the last case, essentially two separate calculations are 

performed with no communication at all between them. Obstructions and vents are entered in terms of 

the overall coordinate system and need not apply to any one particular mesh. Each mesh checks the 

coordinates of all the geometric entities and decides whether or not they are to be included. 

As described in the FDS 5 User Guide (McGrattan, et al., 2007), the following rules of thumb should also 

be followed when setting up a multiple mesh calculation: 

• Mesh Alignment 

The most important rule of mesh alignment is that abutting cells ought to have the same cross 

sectional area, or integral ratios, as shown in Figure 4.4. 

• Mesh Priority 

In general, the meshes should be entered from finest to coarsest. FDS assumes that a mesh with 

higher priority has precedence over a mesh with a lower priority if the two meshes abut or 

overlap. 

• Mesh Boundaries 

Avoid putting mesh boundaries where critical action is expected, especially fire. Sometimes fire 

spread from mesh to mesh cannot be avoided, but if at all possible try to keep mesh interfaces 

relatively free of complicating phenomena since the exchange of information across mesh 

boundaries is not as accurate as cell to cell exchanges within one mesh. 

• Data Exchange 

Information from other meshes is received only at the exterior boundary of a given mesh. This 

means that a mesh that is completely embedded within another receives information at its 

exterior boundary, but the larger mesh receives no information from the mesh embedded 

within. Essentially, the larger, usually coarser, mesh is doing its own simulation of the scenario 

and is not affected by the smaller, usually finer, mesh embedded within it. Details within the 

fine mesh, especially related to fire growth and spread, may not be picked up by the coarse 

mesh. In such cases, it is preferable to isolate the detailed fire behavior within one mesh, and 

position coarser meshes at the exterior boundary of the fine mesh. Then the fine and coarse 

meshes mutually exchange information. 

• Boundary Obstructions 

If a planar obstruction is close to where two meshes abut, make sure that each mesh “sees” the 
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obstruction. If the obstruction is even a millimeter outside of one of the meshes, that mesh may 

not account for it, in which case information is not transferred properly between meshes. 

• Parallel Calculation 

In a parallel calculation, it is recommended that the time steps in all meshes to be the same. This 

is the default setting in PyroSim and FDS 5 and provides a tighter connection between meshes. 

This option is selected by the Synchronize time step for tighter connection between meshes 

checkbox on the Edit Meshes dialog. 

• Trial and Error 

Experiment with different mesh configurations using relatively coarse mesh cells to ensure that 

information is being transferred properly from mesh to mesh. There are two issues of concern. 

First, does it appear that the flow is being badly affected by the mesh boundary? If so, try to 

move the mesh boundaries away from areas of activity. Second, is there too much of a jump in 

cell size from one mesh to another? If so, consider whether the loss of information moving from 

a fine to a coarse mesh is tolerable. 

 
 

This is the ideal mesh 

alignment. 

 
 

This is allowed so long as 

there are an integral 

number of fine cells 

abutting each coarse cell. 

 
 

This is allowed, but of 

questionable value. 

PyroSim will warn if meshes 

overlap. 
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This is no longer allowed in 

FDS 5.1 and higher. PyroSim 

will warn against this mesh 

alignment. 

Figure 4.4. Correct and incorrect mesh alignment 

 

Additional Mesh Actions 
To simplify working with multiple meshes, PyroSim provides the following additional mesh operations: 

 Split Mesh splits selected meshes at a coordinate along a single axis. 

 Refine Mesh makes selected meshes finer or coarser by a factor (e.g. refine a mesh by 4 to turn 1.0 

meter cells into 0.25 meter cells). 

 Merge Meshes combines two or more meshes into a single mesh. 

To use any of the above actions, select one or more meshes, right-click to open a popup menu, then 

click the desired mesh action.
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Chapter 5. Materials  
To simulate a surface made of heat-conducting solids or a fuel you must specify a material that describes 

certain thermal properties and pyrolysis behavior. PyroSim offers two categories of materials: solid 

materials and liquid fuels. 

To create a new material, you can use the Edit Materials dialog. On the Model menu, click Edit 

Materials.... 

Solid Materials 
Examples of solid materials include brick, gypsum board, and upholstery. To create a solid material: 

1. In the Edit Materials... dialog, click New... 

2. In the Material Name box, type the name of the new material 

3. In the Material Type box, select Solid 

4. Click OK 

After following these steps, a default solid material will be created. Text entered in the Description box 

will not affect the simulation, but will be preserved in the FDS input file using the FYI field of the 

material. Including a description of the material is recommended. 

The Thermal Properties tab provides the following options: 

Parameter Description 

Density The material’s density. 

Specific Heat The material’s specific heat. Specific heat can be specified as a 
function of temperature. 

Conductivity The material’s heat conductivity. Conductivity can be specified as a 
function of temperature. 

Emissivity The material’s emissivity. A value of 1.0 corresponds to maximum 
radiation. 

Absorption Coefficient This coefficient refers to the depth over which thermal radiation 
can be absorbed. 

 

The Pyrolysis tab provides options to set the heat of combustion and add reactions that will be used to 

govern how the material burns. Each material can have a maximum of 10 reactions. To add a reaction, 

click Add.... This will open a dialog to edit the new reaction. It provides the following options: 

On the Rate tab: 

Parameter Description 

Achieve reaction rate of The reaction rate at a given temperature. 

at The temperature at which the given reaction rate will occur. 

A (Pre-exponential Factor) (parameter shown in equation) 
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Parameter Description 

E (Activation Energy) (parameter shown in equation) 

Mass Fraction Exponent (parameter shown in equation) 

Exponent (parameter shown in equation) 

Value (parameter shown in equation) 

 

On the Byproducts tab: 

Parameter Description 

Heat of Reaction Heat yield of this reaction. This must be a positive number. 

Endothermic/Exothermic Specifies if the heat yield is endothermic or exothermic. 

Fuel Vapor Yield The mass fraction of yield that will become fuel vapor. 

Water Vapor Yield The mass fraction of yield that will become water vapor. 

Residue Yield The mass fraction of yield that will become residue. If there is 
only one material defined in PyroSim, this option will not be 
available. 

Residue The material that will be used to represent the residue. If 
there is only one material defined in PyroSim, this option will 
not be available. 

 

Liquid Fuels 
Examples of liquid fuels include kerosene and ethanol. To create a liquid fuel: 

• In the Edit Materials... dialog, click New... 

• In the Material Name box, type the name of the new material 

• In the Material Type box, select Liquid Fuel 

• Click OK 

After following these steps, a default solid material will be created. Text entered in the Description box 

will not affect the simulation, but will be preserved in the FDS input file using the FYI field of the 

material. Including a description of the material is recommended. 

The thermal properties tab for liquid fuels is identical to the thermal properties tab for solid fuels (see 

Solid Materials). 

The Pyrolysis tab provides the following parameters: 

Parameter Description 

Heat of Vaporization Heat yield when this liquid fuel is converted to gas. This must 
be a positive number. 

Endothermic/Exothermic Specifies if the heat yield is endothermic or exothermic. 
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Parameter Description 

Fuel Vapor Yield The mass fraction of yield that will become fuel vapor. 

Water Vapor Yield The mass fraction of yield that will become water vapor. 

Residue Yield The mass fraction of yield that will become residue. If there is 
only one material defined in PyroSim, this option will not be 
available. 

Residue The material that will be used to represent the residue. If 
there is only one material defined in PyroSim, this option will 
not be available. 
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Chapter 6. Surfaces 
Surfaces are used to define the properties of solid objects and vents in your FDS model. The surface can 

use previously defined materials in mixtures or layers. By default, all solid objects and vents are inert, 

with a temperature that is fixed at the ambient temperature (set in the Simulation Parameters dialog. In 

addition to defining heat conduction in a solid, surfaces can also be used to define a burner, specify the 

ignition temperature for an object, give a vent a supply velocity, and set the many other properties 

supported by FDS. 

To create, modify, and delete surfaces, you can use the Edit Surfaces dialog. To open the surface 

manager dialog, on the Model menu, click Edit Surface Properties.... The dialog in Figure 6.1 shows the 

dialog being used to edit an upholstery surface. 

 

Figure 6.1. The Edit Surfaces dialog 

Reserved Surfaces 
There are four fundamental or “reserved” surface types: ADIABATIC, INERT, MIRROR, and OPEN. These 

surfaces cannot be changed and are present in every analysis. 

• ADIABATIC 

This surface remains fixed at the ambient temperature. There is no heat transfer (radiative or 

convective) from the gas to an adiabatic solid. 

• INERT 

This surface remains fixed at the ambient temperature. Heat transfer does occur from gases to 

INERT surfaces. This is the default surface in PyroSim. 
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• MIRROR2 

This surface is used only for vents on the exterior mesh boundary. A MIRROR is a no-flux, free-

slip boundary that reverses flow. It is intended to be applied to an entire mesh boundary to 

symmetrically double the size of the domain. 

• OPEN2 

This surface is used only for vents on the exterior mesh boundary. OPEN denotes a passive 

opening to the outside and is often used to model open doors and windows. 

Surface Types 
PyroSim aids the user by organizing the surface options into logical types, such as a burner to define a 

simple fire or a layered surface to represent a solid, heat conducting wall. The available surface types 

are described below. 

Adiabatic 

This surface type is identical to the built-in ADIABATIC surface type. It allows you to customize the 

description, color, and texture of the adiabatic surface described in Reserved Surfaces. 

Inert 

This surface type is identical to the built-in INERT surface type. It allows you to customize the description, 

color, and texture of the inert surface described in Reserved Surfaces. 

Burner 

This surface type represents a fire with a known heat release rate3 or mass (fuel) loss rate. 

Parameters for burner fires are arranged in two groups: heat release and particle injection. Heat release 

options: 

Parameter Description 

Heat Release  

Heat Release Rate (HRR) The heat release rate per unit area of this burner. 

Mass Loss Rate The mass loss rate per unit area of this burner. 

Ramp-Up Time At the beginning of the simulation, this surface will not be 
burning. This field allows you to describe how the heat 
release ramps up from ambient to the specified value. 

Extinguishing Coefficient This parameter governs the suppression of the fire by water. 
For more information, see section 10.7 of the FDS users 
guide. 

Temperature  

Surface Temperature The surface temperature of this burner. The value TMPA 
represents ambient temperature. 

                                                           
2
 Vents of this type should not be toggled (deactivated or activated) during the simulation. 

3
 The heat release rate for a burner surface is specified per unit area. A surface with a 500 kW/m

2
 heat release rate 

applied to a 2.0 m
2
 vent would result in a 1000 kW fire. 
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Parameter Description 

Convective Heat Flux The heat flux per unit area at the surface. 

Ramp-Up Time This field allows you to describe how the temperature ramps 
up from ambient to the specified value. 

Other  

Emissivity This parameter controls how the surface radiates heat. Using 
a value of 1.0 makes this surface a black body. Lower values 
increate the amount of radiated heat. 

 

Particle injection options: 

Parameter Description 

Emit Particles Enable this option to emit particles from the surface. 

Particle Type Select a particle to emit. To create a new particle, click the 
Edit Particles... button. 

Number of Particles per Cell Controls the number of particles inserted per second. A value 
of 1 will insert one particle per cell per second. 

Mass Flux For particles that have mass, this option provides an 
alternate way to control the number of particles inserted per 
second. 

 

Heater/Cooler 

This surface type represents a radiative heat source. The options are identical to the options for a 

burner without the heat release options. If the surface temperature is less than the ambient 

temperature, the surface will remove heat from the surrounding gases. 

Supply 

This surface represents a vent that injects air into the simulation domain. The parameters for supply 

surfaces are arranged in 4 groups: air flow, temperature, species injection, and particle injection. 

Air flow options: 

Parameter Description 

Specify Velocity Use a constant velocity to define air movement through the 
vent. 

Specify Volume Flux Use a constant volume flux to define air movement through 
the vent. 

Specify Mass Flux Use a constant mass flux to define air movement through the 
vent. 

Specify ... Individual Species Define air movement through the vent using a table of extra 
species and their mass fluxes. This method requires a model 
that includes extra (non-reactive) species. Flux data is 
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Parameter Description 

specified on the Species Injection tab. 

Tangential Velocity The tangential velocity of the air flow. The first parameter is 
the velocity in the x or y direction and the second parameter 
is in the y or z direction, depending on the normal direction 
of the vent. An example of tangential velocity is shown in 
Figure 6.2. 

Slip Factor The slip factor affects the calculation of velocity at the walls. 
To specify a no-slip boundary condition, use -1. To specify a 
free slip boundary condition, use 1. Values between -1 and 1 
represent partial slip conditions. 

Ramp-Up Time At the beginning of the simulation, vents with this surface 
will not be blowing. This parameter controls the time it takes 
to ramp the air flow up to the specified amount. 

Wind Profile The default wind profile is constant (Top Hat), to model wind 
conditions outdoors there are two additional options: 
parabolic and atmospheric. Parabolic produces wind with a 
parabolic profile whose maximum is the specified velocity. 
Atmospheric produces a wind profile of the form 
u=u0(z/z0)^p. 

Atmospheric Profile Exponent The term p in the atmospheric profile equation. This option is 
only available when atmospheric profile is selected. 

Atmospheric Profile Origin The term z0 in the atmospheric profile equation. This option 
is only available when atmospheric profile is selected. 

 

 

Figure 6.2. Effect of normal axis on the direction of tangential velocity 

The temperature of the air injected by supply vents can be controlled using the following options: 
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Parameter Description 

Surface Temperature The temperature of the injected air. The value TMPA 
represents ambient temperature. 

Convective Heat Flux The heat flux per unit area at the surface. 

Ramp-Up Time This field allows you to describe how the temperature ramps 
up from ambient to the specified value. 

Other  

Emissivity This parameter is not used for supply surfaces. 

 

The species injection options are available if the Specify Mass Flux of Individual Species option in the 

Air Flow group is selected and there are extra, non-reactive species present in the simulation. 

Particle injection options: 

Parameter Description 

Emit Particles Enable this option to emit particles from the surface. 

Particle Type Select a particle to emit. To create a new particle, click the 
Edit Particles... button. 

Number of Particles per Cell Controls the number of particles inserted per second. A value 
of 1 will insert one particle per cell per second. 

Mass Flux For particles that have mass, this option provides an 
alternate way to control the number of particles inserted per 
second. 

 

Exhaust 

Exhaust surfaces can be used to remove gas from the simulation domain. The specification of their air 

movement parameters is identical to that of a supply surface, but instead of the velocity or flux driving 

air into the domain, they are pulling air out. 

Fan 

A fan is a special type of surface that more accurately simulates a fan than a supply surface. Fans must 

be attached to a thin obstruction that separates two pressure zones. For more information about fans, 

please refer to section 8.3.2 of the FDS User’s Guide. 

Layered 

Layered surfaces are composed of one or more material definitions. Materials include solid and liquid 

substances such as concrete, pine, and ethanol. For more information about materials and how they can 

be specified in PyroSim, please refer to Chapter 5. This type of surface is ideal for walls and other objects 

that are composed of real-world materials. This surface type can also be used to inject extra (non-

reactive) species into the simulation. 
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Layered surfaces have five groups of options: material layers, surface props, reaction, species injection, 

and particle injection. The material layers group contains the following options: 

Parameter Description 

Initial Internal Temperature The initial temperature within this surface. 

Backing The backing of a surface is the boundary condition behind 
the surface. The default value, Air Gap represents an air gap, 
Exposed will allow the surface to transfer heat into the space 
behind the wall, and Insulated prevents any heat loss from 
the back of the material. 

Gap Temperature The temperature of air in the air gap. This option is only 
available when the Air Gap backing type is selected. 

Temperature Ramp This field allows you to describe how the temperature ramps 
up from ambient to the specified value. 

Material Layers  

Thickness The thickness of this material layer. 

Material Composition Within a layer (row), you can specify multiple materials 
based on mass fraction. For example, to specify a layer that is 
just brick, type 1.0 BRICK (assuming you have created a 
material called BRICK). To specify a layer of wet brick, you 
could enter 0.95 BRICK; 0.05 WATER. Each material is 
separated by a semi-colon. 

Edit Click to specify the materials in this layer using an alternate 
table UI. 

 

The Surface Props tab contains the following options: 

Parameter Description 

Geometry The effective geometry for heat transfer calculations. 

Porous The property is generally used to create a fan using a thin 
obstruction. 

Enable Leakage This option allows you to select two pressure zones for 
leakage across the surface. 

Surface Density The mass per unit area for the solid surface, calculated using 
the wall thickness. 

Initial Internal Temperature Starting temperature inside the solid. 

Backing Defines the boundary condition on the back (internal) 
surface of the solid face. 

Gap Temperature Temperature of air gap behind the solid face. 

Temperature Ramp Specifies the surface temperature ramp from ambient, to the 
specified surface temperature. 
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The reaction used to model a given surface can either be taken from the material specifications, or given 

explicitly by the surface. Manually specifying the parameters will produce a surface similar to a burner. 

You can edit this behavior using the reaction options: 

Parameter Description 

Governed by Material This surface’s reaction will be controlled by the materials 
that it is constructed from. 

Governed Manually Override the default reaction behavior for this surface and 
specify the following parameters. 

Heat Release Rate The heat release rate per unit area of this surface. 

Mass Loss Rate The mass loss rate per unit area of this surface. 

Ramp-Up Time This field allows you to describe how the heat release ramps 
up from ambient to the specified value. 

Extinguishing Coefficient This parameter governs the suppression of the fire by water. 
For more information, see section 10.7 of the FDS User’s 
Guide. 

Burn Immediately Select this option to create a surface that is initially burning. 

Ignite at Select this option to create a surface that will begin burning 
at a specified temperature. 

Heat of Vaporization Heat yield when this fuel is converted to gas. 

Allow ... burn away Surfaces of this type can be removed from the simulation 
after expending all available fuel. 

 

You can inject extra (non-reactive) species into the simulation using the species injection options. To use 

these options, you must first specify extra species using the Edit Extra Species dialog. You can edit the 

following extra species options: 

Parameter Description 

Inject by Mass Fraction Select this option to specify species injection using mass 
fractions. 

Inject by Mass Flux Select this option to specify species injection using mass flux. 

Mass Flux of Background 
Species 

The background species (default=AIR) mass flux into the 
domain. 

Background Species Ramp This field allows you to describe how the injection rate ramps 
up from zero to the specified value. 

Species This value cannot be edited. It displays the name of one of 
the species selected in the Edit Extra Species dialog. 

Mass Fraction The mass fraction of an extra species to inject. This option is 
only available if Inject by Mass Fraction is selected. 

Mass Flux The mass flux of an extra species to inject. This option is only 
available if Inject by Mass Flux is selected. 
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Parameter Description 

Ramp-Up Type This field allows you to describe the function used to ramp 
up the injection rate from zero to the specified value. 

Ramp Value The time it takes to achieve the specified injection rate. 

 

The particle injection parameters for layered surfaces are identical to those for burners. 

Air Leak 

Air leak surfaces can be used to create a permeable barrier between two pressure zones. The porous 

option is available to allow air movement to occur across the obstructions using this surface. 

Adding Textures to Surfaces 
You can add textures to surfaces to increase the realism of your model. Some default textures are 

provided or you can import your own. The Room Fire example demonstrates using a wood texture for a 

pine floor and hanging a picture on a wall. Your textures will be automatically displayed in PyroSim; to 

display textures in Smokeview, select Textures on the Show/Hide menu. 

To define a texture: 

1. On the Model menu, click Edit Surfaces.... 

2. Either create or edit the surface to which you want to add a texture. 

3. Click on the Texture box. 

4. Either select a pre-defined texture or click the Import... button and select your own image file. 

5. The image you selected will be displayed. Under the image, click the Details tab. Set the Width 

and the Height values to correspond to size to be used in the PyroSim model. 

6. Click OK to close the Textures dialog. 

The textured surface can now be used in either obstructions or vents.
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Chapter 7. Geometry (Basic Concepts)  
PyroSim provides tools to help the user rapidly create and organize model geometry.  

Geometry can either be created through dialogs or by using the drafting tools in the 2D or 3D views as 

discussed in Chapter 8. There are typically three types of geometry that can be created in PyroSim:  

 Obstructions – solid barriers to flow 

 Holes – negative regions that carve holes in obstructions 

 Vents – patches that define a sub region on an obstruction’s surface that can have a different 

surface than the rest of the obstruction 

The user can also organize the model by creating floors and groups.  In addition, the user can assign 

background images to floors to aid in drafting. 

Obstructions 
Obstructions are the fundamental geometric representation in FDS. In FDS, obstructions are rectangular, 

axis-aligned solids defined by two points. Surface properties are assigned to each face of the obstruction.   

In PyroSim, obstructions can take any shape, have any number of faces, and have different surfaces 

applied to each face.  At the time of simulation, PyroSim will automatically convert the obstructions to 

axis-aligned blocks required by FDS as discussed in Angled Geometry on page 120.  

FDS defines two types of obstructions: 

 Solid Obstructions –obstructions that are at least one grid cell thick in all dimensions.  FDS 

allows heat transfer calculations only on these types of obstructions. In addition, only these 

obstructions can have vents applied. 

 Thin Obstructions –obstructions that have zero thickness in one dimension.  These obstructions 

are mainly used to prevent flow.  In addition, only this type of obstruction may be a fan as 

discussed in Chapter 6. 

Figure 7.1 shows an example of a polygonal slab drawn in PyroSim and its conversion to blocks for use in 

FDS. 
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a b 

Figure 7.1. Conversion of a slab obstruction to FDS blocks 

Creating Obstructions 

To create a new obstruction, either use an obstruction drawing tool as discussed in Chapter 8 or on the 

Model menu, click New Obstruction... or New Slab…. 

 

Figure 7.2. Obstruction dialog 

General 

This tab of the obstruction panel presents all options other than those controlling geometry and surface 

information. This includes activation events (conditions that can cause the obstruction to be added or 

removed from the simulation) and miscellaneous options such as color and smoothing. 

Parameter Description 
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Parameter Description 

Description A human-readable description for the object. This value will 
not affect the result of the simulation. 

Group Controls the position of the object in PyroSim’s tree view. 

Activation Bind this object to new or existing activation control logic. 
Activation control logic is used to add or remove the object 
based on time or measurement conditions. To learn more 
about activation events, please refer to Chapter 14. 

Specify Color Override the material colors for this object. 

Texture Origin  

Relative to Object When textures are attached to an object, they are tiled 
based on an origin point. By default, this point is the origin; 
Relative to Object makes the anchor point the minimum 
point of the object. 

x,y,z These values offset the texture origin based on the default 
texture origin. If the origin is relative to the object, leave at 
zero to use the object’s min point. 

Obstruction Properties  

Smooth Prevents vorticity from being generated at the corners. This 
option is used to prevent flow problems along angled walls 
due to the stair-stepped, rectilinear geometry used by FDS. 

Thicken When this option is selected, this object will not be reduced 
to 2D faces by FDS. This is needed for obstructions to have 
vents attached. 

Record BNDF When this option is selected, this object is included in 
boundary data output. 

Permit Holes When this option is selected, holes can modify the geometry 
of this object. 

Allow Vents Makes it possible for this object to be the backing object for 
a vent. 

Removable Makes it possible for the object to be removed from the 
simulation by activation events or the BURN_AWAY surface 
option. 

Display as Outline Changes the appearance of this object. 

Bulk Density Use this option to override the amount of fuel provided by 
this object. 

Geometry 

This tab allows you to enter the min and max coordinates of the object. For more elaborate geometry, 

such as slabs, this tab may contain a table of points and extrusion options. Extrusion is the mechanism 

PyroSim uses to extend 2-dimensional objects along a vector - creating a 3-dimensional object. 
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Surfaces 

By default, all six sides of an obstruction use the INERT surface. The Surfaces tab can be used to specify 

one surface to be used for all six sides of the object or assign surfaces on a per-face basis. Alternately, 

surfaces can be “painted” using the Paint Tool as discussed in Painting Obstructions and Vents on page 

75. 

Holes 
Holes are used to carve negative spaces out of obstructions.  In FDS, holes are similar to obstructions in 

that they are defined as axis-aligned blocks.  Like obstructions in PyroSim, however, holes can be any 

shape.  PyroSim automatically converts them to blocks in the FDS input file.   

PyroSim treats holes as first-class objects that be selected, deleted, and have other operations 

performed on them similar to obstructions as discussed in 0.  

In the 3D and 2D views, holes appear as transparent objects.  In addition, for display purposes only, 

PyroSim carves holes out of obstructions as shown in Figure 7.3.  For complex holes or obstructions or 

large holes that span many obstructions, this process may be fairly slow.  In these cases, hole-cutting 

display can be turned off by going to the View menu and deselecting Cut Holes From Obstructions. 

While PyroSim will display obstructions with holes cut from them, it will NOT cut holes when creating 

the FDS input file.  Instead, PyroSim converts holes and whole obstructions to blocks separately.  

PyroSim makes no attempt to remove obstructions that overlap holes from the FDS input file. 

By default, all obstructions allow holes to be cut from them.  To prevent an obstruction from allowing 

holes, edit the properties of the obstruction as discussed in 0 and deselect Permit Holes. 

 

Figure 7.3. A slab obstruction with a hole cut from it 
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Creating Holes 

Holes can either be drawn as discussed in Chapter 8 or can be created by opening the Model menu and 

clicking New Hole….  This will open the Hole Properties dialog as shown in Figure 7.4. 

 

Figure 7.4. Hole Properties dialog 

Like obstructions, holes can also be activated as discussed in Chapter 14.  Holes can also have a color 

applied. 

Vents 
Vents have general usage in FDS to describe a 2D rectangular patch on the surface of a solid obstruction 

or on a mesh boundary as shown in Figure 7.5. A vent may have a different surface applied to it than the 

rest of the obstruction to which it is attached. 

 

Figure 7.5. Vents on a mesh boundary and obstruction 



Geometry (Basic Concepts) 

 

46 

Taken literally, a vent can be used to model components of the ventilation system in a building, like a 

diffuser or a return. In these cases, the vent coordinates form a plane on a solid surface forming the 

boundary of the duct. No holes need to be created through the solid; it is assumed that air is pushed out 

of or sucked into duct work within the wall. 

You can also use vents as a means of applying a particular boundary condition to a rectangular patch on 

a solid surface. A fire, for example, is usually created by first generating a solid obstruction and then 

specifying a vent somewhere on one of the faces of the solid with the characteristics of the thermal and 

combustion properties of the fuel. 

There are two reserved surface types that may be applied to a vent: OPEN and MIRROR. For more 

information on these types, see Chapter 6. 

Creating Vents 

Vents can either be drawn as discussed in Chapter 8 or be created by opening the Model menu and 

clicking New Vent….  This will open the New Vent dialog as shown in Figure 7.6. Like obstructions and 

holes, vents can also be activated, but only if the surface is not MIRROR or OPEN. With the exception of 

Fire Spread, the other properties are similar to obstructions.  Fire Spread can be specified on vents using 

a burner surface (Chapter 6).  This option simulates a radially spreading fire at the vent. 

 

Figure 7.6. New Vent dialog 

Groups 
Groups can be used to hierarchically organize the model. Groups can only be seen in the Navigation 

View. The “Model” is the base group. Users can nest groups inside other groups, allowing the user to 
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work with thousands of objects in an organized way. When the user performs an action on a group, that 

action will be propagated to all objects in the group. 

Creating Groups 

There are two ways to create a group: 

 Right-click the desired parent group from the Navigation View and select New Group… from the 

context menu.  This will create a child group in the selected parent. 

 Click the New Group… button ( ) from the main tool bar.   

Both of these actions will show the Create Group dialog as shown in Figure 7.7.  This dialog allows the 

user to choose the parent group and name of the new group. 

 

Figure 7.7. Create Group dialog 

Adding Objects to Groups 

There are several ways to add objects to a group: 

 For existing objects, in the Navigation View, select the objects and drag them into the desired 

group as shown in Figure 7.8.  Alternatively, right click them in any view and select Change 

Group….  In the Change Group dialog shown in Figure 7.9, select the desired group.  If a new 

group is desired, select New Subgroup and specify a name.  If this is chosen, a new group will be 

created under the specified existing group, and the selected objects will be moved to this new 

group. 

 For newly drawn objects, in the 3D or 2D view select the desired group from the group drop-

down above the view as shown in Figure 7.10.  All newly drawn objects will be added to this 

group. 
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1 2 3  

  

 

 

Figure 7.8. Dragging objects to a new group in the Navigation View 

 

Figure 7.9. The Change Group dialog 

 

Figure 7.10. The Group drop-down 

Floors  
Floors are used in PyroSim to quickly apply clipping filters to the scene to only show a portion of the 

model. 

To define the floors in a model, go to the 2D or 3D View and click the Define Floor Locations button . 

This will display the Manage Floors dialog shown in Figure 7.11. 
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Figure 7.11. Manage Floors dialog 

Floors are defined by the following properties: 

 Elevation – the Z location at which walls and other obstructions will be drawn.  This is the 

location where occupants would walk on that floor. 

 Slab Thickness – the thickness of the slab for the floor.  When the active floor is changed, this 

value is applied to the slab drawing tools but can be changed in the slab tool’s properties.  This 

value is used such that the top of the slab is at the elevation and the bottom is at the elevation 

minus slab thickness. 

 Wall Height – the height of the walls for floors.  When the active floor is changed, this value is 

applied to the wall drawing tools but can be changed in the wall tool’s properties.  Walls are 

drawn from the elevation to the elevation plus wall height. 

 Background Image – an image display along with the floor that can be traced over. 

To add a new floor, click the Add Floor… button at the top of the Manage Floors dialog.  This will show 

the New Floor dialog shown in Figure 7.12.  By default this dialog will assume the user wants a floor 

above the previous floor using that floor’s slab thickness and wall height properties.  In this dialog, if the 

user enters a new slab thickness, the elevation will be automatically updated so the new floor does not 

overlap the others unless the user enters a specific value for the elevation.  In addition, unless the user 

enters a specific name, a name will be automatically generated based on the elevation. Press OK to 

create the new floor. 



Geometry (Basic Concepts) 

 

50 

 

Figure 7.12. New Floor dialog 

Press OK again in the Manage Floors dialog to commit the changes. 

By default, the model contains one floor at elevation 0.0 m with a slab thickness of .25 m and a wall 

height of 2.75 m. Using these values leaves a distance of 3.0 m from one floor elevation to another. 

Once the floors have been defined, the user can filter the display to show either a single floor or all 

floors as shown in Figure 2.5.  For most views, the Z clipping range for a particular floor is from the floor 

elevation minus slab thickness to floor elevation plus wall height. The Z clipping range works differently 

for the top camera of the 2D view, however. In this view, the clipping is from the elevation of the floor 

BELOW to the elevation plus wall height of the current floor. This allows the geometry on the floor 

below to be snapped to in drawing geometry for the current floor.  For this to be useful, however, the 

user may want to use wireframe rendering. 

Adding a Background Image to a Floor  
Each floor can have an associated background image. To add a background image to a floor, go to the 2D 

or 3D View, select a specific floor, then click the Configure Background Image button  (alternately 

click the Define Floor Locations button, , and then in the Background Image column, select the Edit 

button). This will display the Configure Background Image dialog shown in Figure 7.13. You will be 

guided through the following steps: 

1. Choose a background image file. Valid image formats are bmp, dxf, gif, jpg, png, tga, and tif. 

2. Specify the Anchor Point for the image by clicking on the image. The Anchor Point is a point on 

the image at which the coordinates are specified in the model coordinate system. The model 

coordinates of the anchor point are not required to be at the origin. 

3. Set the model scale. Select the Choose Point A button, then select the first point that will be 

used to define a length. Select the Choose Point B button and select the second point to define 

a length. Input the Distance between points A and B. 

4. Use the sliding scale to change the image transparency. 
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5. If the image needs to be rotated, check the box next to Dist. A to B and enter an angle.  This 

specifies the angle between the positive X axis and the vector from reference point A to B.  For 

instance, if A->B should be aligned with the X axis, enter 0 for the angle or if A->B should be 

aligned with the positive Y axis, enter 90. 

6. Click OK to close the Configure Background Image dialog. 

 

Figure 7.13. Display of background image 

Now, in the 3D or 2D views, when the user displays a specific floor, the background image for that floor 

will be displayed. To turn off the background images, go to the 2D or 3D View, and click the Show 

Background Images button  next to the floors drop-down.
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Chapter 8. Drawing in PyroSim 
While not a full-fledged drafting application, PyroSim does provide useful drawing features, including 

the following: 

 Snapping to grids, objects, and polar and orthographic constraints 

 Precise keyboard entry 

 3D and 2D drawing, each having strengths over the other 

 Mesh, Obstruction, Hole and Vent drawing tools 

 Editing tools 

 Transforming tools 

 Surface painting tools for obstructions and vents 

Drawing/Editing Tool Overview 
PyroSim provides several drawing and editing tools.  These tools are located on the drawing toolbar at 

the left side of the 3D and 2D Views as shown in Figure 8.1. 

 

Figure 8.1. Drawing/Editing toolbar 

Some of these tools allow a user to create and edit objects such as slabs and walls that are not 

constrained to the FDS mesh. In these cases, PyroSim will automatically convert the shapes to mesh-
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based blocks when the FDS input file is created. These blocks can be previewed by clicking the Preview 

FDS Blocks button ( ) on the filter toolbar above the 3D or 2D View.  For information on block 

conversion, see Angled Geometry on page 120.  

Selecting a Tool 

To begin drawing or editing with a tool, the user can single-click the tool from the tool bar.  Once the 

tool has finished drawing/editing its object, the last-used navigation tool is automatically selected.   

If the user would like to create several objects with the same tool in succession, the desired tool can be 

pinned by clicking the tool’s button twice.  The button will show a green dot when pinned as shown in 

Figure 8.2. 

  
Figure 8.2. Pinning a drawing/editing tool 

Every time the same tool button is clicked, the pinned state of that tool will be toggled, so clicking the 

button again after pinning will disable pinning. 

At any time, the current drawing/editing tool can be cancelled by pressing ESC on the keyboard.  This 

will also cancel pinning and will revert back to the last-used navigation tool. 

Tool Modes 

Most drawing/editing tools require at least two points to be specified to complete its action, such as 

drawing the points for a wall or defining the extents of a box.  These tools can operate in two modes: 

 Multi-click mode: This mode allows the user to specify each desired point by single-clicking the 

left mouse button for each point.  This mode also facilitates precise keyboard entry.  

 Click-drag mode: This mode only allows the user to specify two points.  When the left mouse 

button is pressed, the first point is committed. Then the mouse is dragged to the next location 

while still holding the left mouse button.  The button is then released to specify the second 

point. 

Tool Properties 

Each tool has a set of properties that can be modified by clicking the Tool Properties  button located 

at the bottom of the toolbar after selecting the desired tool. Options such as elevation, height, surface, 

and color can all be edited in the Tool Properties dialog.  

Quick Actions 

In addition to the tool properties, each tool also has additional quick actions. To show these actions, 

start the desired tool and then right-click in the 2D or 3D View.  This opens a context menu with the 

quick actions. Figure 8.3 shows an example of the quick action menu for the wall tool.   



Drawing in PyroSim 

 

54 

 

Figure 8.3. The quick action menu for the wall tool 

This menu allows the user to perform actions specific to the tool, such as closing a polygon, picking a 

surface, setting wall alignment, accessing the tool properties, etc. 

Snapping 
Snapping is one way to precisely draw and edit objects.  It is the process of finding some element in the 

scene, such as a vertex or edge close to the cursor, and snapping the cursor to that element like a 

magnet.   

In PyroSim, snapping can be performed against the solution meshes, objects in the model, and 

orthographic constraints.  The 2D View additionally provides a sketch grid and polar (angle) constraints. 

If a snap point is found, an indicator dot will appear at the snap point as shown in Figure 8.4. 

  
Figure 8.4. Snap indicator 

By default, snapping is enabled.  It can be disabled by holding ALT on the keyboard while using a 

drawing/editing tool. 

Solution Mesh Snapping 

If there are any solution meshes in the model (see Chapter 4), PyroSim can snap to them during drawing 

and editing.  For each mesh that is visible, PyroSim can snap to its boundary edges, boundary faces, grid 

lines, and the intersections of the grid lines, depending on which mesh display filters are active as 

discussed in Filtering on page 11. 

Sketch Grid Snapping (2D View Only) 

PyroSim also provides a user-defined drawing grid, or sketch grid, in the 2D View as shown in Figure 8.5.   
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Figure 8.5. Sketch grid 

When a new model is created, the sketch grid is visible and can be snapped to in the 2D view. The 

default spacing for the divisions is 1 m, but can be changed by going to the View menu and clicking Set 

Sketch Grid Spacing….   

Once the user has created a solution mesh, PyroSim will automatically switch to solution mesh snapping 

and disable sketch grid snapping.  In the 2D View, PyroSim will only snap to the sketch grid or visible 

solution meshes.  To switch which snapping is being used, on the View menu choose Snap to Sketch 

Grid or Snap to Model Grids.  To disable grid snapping altogether, on the View menu choose Disable 

Grid Snapping. 

Modeling Hint: In FDS, the spatial resolution of the solution is defined by the solution mesh, not the 

Sketch Grid. Using the solution mesh for 2D View drawing ensures that the model geometry matches 

the FDS solution geometry. Some users create all model objects using mesh dimensions. While this leads 

to a “blocky” appearance, it does represent the true solution geometry and ensures there will be no 

unexpected gaps in the model. 

Object Snapping 

All objects displayed in the model can be snapped to when using the drawing/editing tools.  There are 

three basic categories of geometry that can be snapped to on objects: faces, edges, and vertices.  

Objects can have any combination of types.  If there are multiple types close to the cursor, PyroSim will 

give vertices precedence over edges and edges precedence over faces. 

Constraint Snapping 

Constraints are dynamic snapping lines that are only visible when the cursor is near them.  They appear 

as infinite dotted lines as shown in Figure 8.6.  PyroSim contains two types of constraints: 
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 Orthographic: These constraints allow the user to snap to a line parallel to the X, Y, or Z axis 

from the last relevant point.  For instance, when drawing a polygonal slab, after each point 

specified, there will be three orthographic constraints extending from the last drawn point to 

aid in drawing the next point. 

 Polar (2D View Only ): These constraints are similar to orthographic constraints, but they are 

found at 15 degree increments from the current view’s local X axis. 

 

Figure 8.6. Polar constraint at an angle of 45 degrees 

Constraint Locking 

 If a constraint is currently being snapped to, that constraint can be locked by holding SHIFT on the 

keyboard.  While holding SHIFT, a second dotted line will extend from the cursor to the locked 

constraint (the first dotted line). This is useful for lining up objects along a constraint with other objects.   

For instance, in Figure 8.7, a box already exists in the model. A second slab is being drawn such that the 

third point of the slab lines up with the right side of the first box.  This was done as follows: 

1) After the second point for the slab was clicked, the cursor was moved until the X-axis 

constraint became visible. 

2) SHIFT was pressed and held on the keyboard to lock the constraint. 

3) The cursor was moved to a point on the right edge of the box while still holding SHIFT.  

NOTE: The distance displayed in the figure is the distance from the second point to the third point on 

the locked constraint and NOT from the second point to the cursor location. 
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Figure 8.7. Locked constraint 

Precise Keyboard Entry 
While using a drawing/editing tool, a popup window may appear next to the cursor, such as in Figure 8.8.  

This window shows the value used to determine the next point or value for the current tool.  In this 

figure the value is the Distance from the previous point along the vector from the previous point to the 

current cursor location. For other tools, this value may be angle or relative offset, etc. 

The value is editable if the status bar at the bottom of the 3D or 2D View indicates it is.  For instance, in 

the figure, the status bar says “<Type to enter Distance or press TAB for alternatives>”. If the user starts 

typing, the popup window will be replaced with an editing window as shown in Figure 8.9.  If the user 

presses ENTER, the typed value will be committed.  If the user presses ESC instead, the keyboard entry 

will be cancelled.  

Pressing TAB cycles through alternate input methods to determine the next value.  For instance, 

pressing TAB with the wall tool allows the user to enter a relative offset from the last point instead of a 

distance.  Pressing TAB a second time allows the user to enter an absolute position for the next point, 

and pressing TAB a third time will cycle back to the distance input. 
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Figure 8.8. Tool editor window 

  

Figure 8.9. Precise keyboard entry 

Precise keyboard entry may be easiest for some users when using the multi-click mode of drawing 

rather than using the click-drag mode.  Using multi-click allows both hands to be used to type as 

opposed to click-drag, which requires one hand to remain on the mouse.  

2D versus 3D Drawing 
There are some key differences between drawing in the 2D and 3D Views.  The 2D View is useful when 

drawing should be restricted to one pre-defined plane.  It is also useful for lining up objects along the X, 

Y, or Z axes.  The 3D View is useful when an object such as a vent or solid-phase device needs to be 
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snapped to the face of an obstruction or vent or if the user would like to build objects by stacking them 

on top of one another. 

2D View Drawing 

When drawing in the 2D View, the drawing will always take place in the drawing plane specified in the 

tool properties, and snapping is only performed in the local X and Y dimensions.  The local Z value will 

remain true to the drawing plane.  In addition, if a tool has some sort of height or depth property, the 

tool will also remain true to that value.  Figure 8.10 shows two slabs that have been drawn in the top 

view, one at Z = 0 m and the other at Z = 1.5 m.  While snapping was used to partially align the objects, 

they both remain in the Z planes specified in their tool properties. 

  
Figure 8.10. Slabs in different planes aligned in the 2D View 

3D View Drawing 

The 3D View uses snapping in all three dimensions, causing tool properties to be interpreted more 

loosely.  The drawing plane and depth properties for a drawn object are context-sensitive in the 3D 

View.  When using tools such as the slab tool, the first clicked point determines the drawing plane.  If, 

on this first click, another object is snapped to, the drawing plane is set at the Z location of that snap 

point.  The tool properties’ drawing plane is only used if nothing is snapped to on the first click.   

This 3D snapping feature of the 3D View is useful for drawing vents on obstructions and attaching solid-

phase devices to obstructions as shown in Figure 8.11. 
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Figure 8.11. Vent and devices attached to a wall 

The 3D snapping feature is also useful for stacking objects, as shown in Figure 8.15.  In this figure, the 

drawing plane was never changed.  All the objects were stacked on top of each other using snapping.   

 

Figure 8.12. Objects stacked in the 3D View 

Holes in the 3D View 

While stacking can be useful for obstructions, a user must be more careful when drawing holes in the 3D 

View.  For instance, with the slab hole tool and block hole tool, the user will need to change the 

extrusion direction to properly direct the hole into the obstruction.  For instance, if the user draws a slab 

obstruction in the 3D View and then draws a slab hole while snapping to the obstruction, the hole will 

be stacked on top of the obstruction without cutting a hole as shown in Figure 8.13 (A).  To draw this 
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properly, the user would need to change the extrusion direction when drawing the hole by pressing 

CTRL on the keyboard or changing it through the tool’s right-click menu.  This will result in a proper hole 

as shown in Figure 8.13 (B). This is not a problem in the 2D View since it always uses the drawing plane 

set in the tool properties instead of stacking the objects. 

  
A B 

Figure 8.13. Improper vs proper hole drawing in the 3D view 

Projected Drawing in the 3D View 

Once the drawing plane for a tool has been established by the first click, the tool can still determine the 

next points by snapping to objects in another plane.  In this case, the snapped points will be projected to 

the drawing plane for the current tool.  A dotted line will show how the snapped point was projected to 

the plane.  For instance, Figure 8.14 shows a new slab being drawn in the Z = 1.5 plane.  A slab below the 

new slab is being snapped to determine the new slab’s points. 

 

Figure 8.14. Snapping to another plane in the 3D View 

Obstruction Drawing Tools 
There are four tools that can draw obstructions (for more information on obstructions, see Obstructions 

on page 41). 
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  Slab Obstruction Tool: Used to draw the slab for a floor 

  Wall Obstruction Tool: Used to draw a wall 

  Block Obstruction Tool: Used to fill grid cells with obstructions 

  Room Tool: Used to draw a rectangular room 

For all the obstruction tools, the tool properties dialog ( ) will appear similar to that in Figure 8.15.  

The only section of the dialog that will change between these tools is the geometry, such as Z Location 

and Thickness.  All other properties, including name, surface, color, and obstruction flags appear in all 

obstruction dialogs.  These parameters control the properties that will be applied to the next drawn 

obstruction. 

 

Figure 8.15. Tool properties dialog for obstructions 

 The surface and color of the next obstruction can also be set via the right-click menu for the tool. 

Slab Obstruction Tool 

A slab is an extruded polygonal object as shown in Figure 8.16 that can be used to draw the slab for a 

floor in a building.  
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Figure 8.16. A polygonal slab obstruction 

The slab obstruction tool  adds two additional properties to the tool dialog for obstructions: 

 [X,Y, or Z] Location: the drawing plane for the slab.  When the active floor is changed, this is set 

to the floor’s elevation minus the floor’s slab thickness. 

 Thickness: the thickness of the slab. When the active floor is changed, this is set to the floor’s 

slab thickness. If this value is positive, the slab is extruded toward the camera. If it is negative 

the slab is extruded away from the camera.  The extrusion direction can be toggled by pressing 

CTRL on the keyboard or from the tool’s right-click menu.  

To draw the polygon vertices of the slab obstruction, perform the following: 

1. Select the Slab Obstruction Tool  from the drawing toolbar. 

2. Define the slab points using one of the two tool modes: 

 Use Click-drag mode to draw an axis-aligned box between two points. 

 Use Multi-click mode to click several points defining the polygonal boundary for the slab.  

The slab will automatically close if the first point is clicked again or if the user selects 

Close from the right-click menu. 

Wall Obstruction Tool 

The wall obstruction tool  can be used to draw multi-segmented walls as shown in Figure 8.17. In this 

figure, there is only one wall. The user specifies a path along the floor from which the wall is extruded 

up.  The wall can be aligned to the left, right, or center of the drawn path. 
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Figure 8.17. A wall obstruction 

The wall obstruction tool adds three properties to the tool properties dialog: 

 Z Location: the drawing plane for the bottom of the wall.  When the active floor is changed, this 

is set to the floor’s elevation property. 

 Height: the height of the wall.  This must be positive. When the active floor is changed, this is 

set to the floor’s wall height property. 

 Wall Thickness: the thickness of the wall. 

The alignment of the wall can be controlled through the right-click menu for the tool or can be cycled by 

pressing the CTRL key on the keyboard. The alignment options are shown in Figure 8.18. 

   
Left-aligned Right-aligned Center-aligned 

Figure 8.18. Wall alignment options 

To draw a wall, perform the following steps: 

1. Select the Wall Obstruction Tool  from the drawing toolbar. 

2. Define the wall points using one of the two tool modes: 

 Use Click-drag mode to draw a single wall segment. 
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 Use Multi-click mode to click several points, with wall segments between each pair of 

points.  If the first clicked point is clicked again after drawing at least two segments or 

Close is chosen from the right-click menu, the tool will draw one last segment from the 

last clicked point to the first point and finish. Alternately, the wall can be ended at the 

last clicked point by choosing Finish from the right-click menu. 

Block Obstruction Tool 

The Block Obstruction Tool  can be used to quickly fill grid cells with blocks as shown in Figure 8.19 or 

place a block with a single click.  

 

Figure 8.19. Blocks drawn with the block obstruction tool 

This tool adds the following properties to the tool properties dialog: 

 [X,Y, or Z] Location: the drawing plane. When the active floor is changed, this is set to the 

floor’s elevation. 

 Height: the distance the block is extruded toward or away from the camera.  When the active 

floor is changed, this is set to the floor’s wall height property. 

 Size: the size of the block when there is no snap grid under the cursor. 

In addition, the extrusion direction for the block can be toggled by pressing CTRL on the keyboard or 

through the right-click menu for the tool. 

To create blocks using this tool, perform the following: 

1. Select the Block Obstruction Tool  from the drawing toolbar. 

2. If a solution mesh or sketch grid is visible, either click the desired cell to fill or click-drag the 

mouse across the grid to “paint” blocks. The depth of the cells will not necessarily be the depth 
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of a cell in the filled mesh, however. The depth is strictly controlled by the height property for 

the tool. 

Room Tool 

The room tool  can be used to draw a rectangular room using one closed wall as shown in Figure 8.20. 

 

Figure 8.20. A room drawn with the room tool 

The room tool contains the same properties as the wall obstruction tool. 

To draw a room with the room tool perform the following: 

1. Select the Room Tool  from the drawing toolbar. 

2. Use Click-drag mode or Multi-click mode to draw two points defining the extents of the room. 

Hole Drawing Tools 
There are three tools that can draw holes (for more information on holes, see Holes on page 44). 

  Slab Hole Tool: Used to draw a hole in a floor slab. 

  Wall Hole Tool: Used to draw an opening in a wall, such as for a doorway or window. 

  Block Hole Tool: Used to fill grid cells with holes. 

All these tools work the same as their obstruction counterparts, but they do not have the properties 

specific to obstructions, such as the surface or obstruction flags. 

Vent Tool 
There is only one tool for drawing vents (for more information on vents, see Vents on page 45).  PyroSim 

only allows vents in an X, Y, or Z plane.  Vents cannot currently be drawn off-axis like walls can.  
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Vents also must be attached to solid obstructions (at least one grid cell thick).  This is easily 

accomplished by drawing the vent in the 3D View (see 2D versus 3D Drawing on page 58). 

To draw a vent, perform the following: 

1. Select the Vent Tool  from the drawing toolbar. 

2. Use Click-drag Mode or Multi-click Mode to specify two points that define the extents of the 

vent.   

 When this is performed in the 2D View, the vent will be drawn in the plane specified in 

the tool properties and is view-dependent (in the top view, the vent will be drawn in the 

XY plane, in the front view, the vent will be drawn in the XZ plane, etc.).   

 If the vent is drawn in the 3D View, the vent will be drawn in the plane containing the 

two specified points.  If the two points are not in an axis-aligned plane, an axis-aligned 

plane will be chosen containing the first point while maximizing the area of the vent. 

Solution Mesh Tool 
Solution meshes can also be drawn in PyroSim with the solution mesh tool  as shown in Figure 8.21.  

 

Figure 8.21. A solution mesh drawn with the mesh tool 

The solution mesh tool  has the following tool properties: 

 [X,Y, or Z] Location: The drawing plane containing the bottom of the mesh.  When the active 

floor is changed, this is set to the floor’s elevation minus the floor’s slab thickness. 

 Height: The depth of the mesh in the current view.  When the active floor is changed, this is set 

to the floor’s wall height plus the floor’s slab thickness. 
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 Cells: Define how cells are generated as the mesh is being drawn.  This can be one of two values: 

fixed size, or fixed count: 

o Fixed Size: each cell will have a fixed size.  While drawing the mesh, the mesh boundary 

will snap to integer multiples of the cell size.  Figure 8.22 (A) shows a mesh drawn with 

fixed cell sizes of .25 x .25 x .25 m.  As can be seen, the grid has been snapped 

away from the cursor the nearest multiple of .25 m. 

o Fixed Count: each dimension of the drawn mesh will be evenly divided to have the 

specified number of cells.  Figure 8.22 (B) shows a mesh drawn with fixed counts of 10 

x 10 x 10. As can be seen, the cells are stretched to match the drawn mesh 

boundary. 

  
A B 

Figure 8.22. Two types of drawn meshes 

To draw a solution mesh, perform the following: 

1. Select the Solution Mesh Tool . 

2. Use the Click-drag Mode or Multi-click Mode to draw two points defining the extents of the 

mesh. 

Mesh Splitter Tool 
Solution meshes can be easily split into two or more sub-meshes by using the mesh splitter tool .  To 

split one or more meshes, perform the following: 

1. Select the desired meshes to split either in the navigation view or by holding g on the keyboard 

while selecting a grid in the 2D or 3D view. 

2. Select the Mesh Splitter Tool . 

3. Move the cursor over one of the meshes.  A preview slice will show where the meshes will be 

split as shown in Figure 8.23.  By default the tool will choose the split axis based on the nearest 

boundary edge of a selected mesh.  The split axis can be explicitly set through the right-click 



Drawing in PyroSim 

 

69 

menu, in the tool properties dialog, by click-dragging the left mouse button, or by pressing CTRL 

on the keyboard to cycle through the options. 

4. Once the desired split location can be seen, left-click the mouse to set the location.   

5. Repeat steps 3) and 4) to set more split locations.  The meshes can be split along any number of 

axes in a single operation. 

6. To perform the split, right-click in the 2D or 3D view and select Finish. 

7. PyroSim will create a new mesh group for each selected mesh and place the resulting meshes in 

the appropriate groups. 

 

Figure 8.23. Meshes being split by the mesh splitter tool 

Device Tool 
PyroSim allows point devices to be drawn with the device tool  (for more information on devices, see 

Chapter 13).  

The device tool has the following properties: 

 [X,Y, or Z] Location: The drawing plane on which to place the device.  When the active floor is 

changed, this is set to the floor’s elevation plus the floor’s wall height*.5. 

 Device Type: The type of point device to draw.  This can include sprinklers, smoke detectors, 

gas-phase devices, solid-phase devices, etc.  Changing the device type also changes the other 

properties editable in the properties dialog.  For more information on properties for each device 

type, see 0. 

To draw a device, perform the following: 

1. Select the Device Tool . 

2. Click on the desired location. 
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NOTE: When drawing a device in the 3D View, the device’s location will snap differently depending on 

whether the device is a solid-phase device, such as one that measures wall temperature, or a gas-phase 

device, such as a smoke detector.  If it is a solid-phase device, the device’s location will snap directly to 

the point under the cursor if one is found.  This makes it trivial to attach a solid-phase device to an 

obstruction.  If the device is a gas-phase device, however, the device’s location will be projected to the 

plane as set in the device tool properties as shown in Figure 8.24.  This makes it easy to draw devices at 

a specific height above the floor.  This behavior can be overridden for either type of device by selecting 

Lock Z to [V] (where V is the drawing plane) or Lock Z to Snap Location in the tool’s right-click menu.  

Lock Z to [V] is the automatic behavior for gas-phase devices and Lock Z to Snap Location is the 

automatic behavior for solid-phase devices. 

 

Figure 8.24. A gas-phase device being drawn in the 3D View 

Planar Slice Tool 
Planar slices, as discussed in Slices on page 108 can be drawn with the planar slice tool .  To do so, 

perform the following: 

1. Select the Planar Slice Tool . 

2. In the tool properties dialog, select the desired quantity to record on the slice, the desired plane 

on which to draw the slice, and whether to include flow vectors. 

3. Move the cursor to the desired slice location.  A preview slice will be displayed as shown in 

Figure 8.25.1  The slice plane can be changed through the right-click menu, by click-dragging the 

left mouse button, or by pressing CTRL on the keyboard to cycle through the options. 

4. Left-click the mouse to create the slice. 

                                                           
1
 A planar slice can only be seen if the slice intersects a solution mesh. 
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Figure 8.25. Drawing a slice with the planar slice tool 

Other Drawing Tools 
PyroSim can also be used to draw Init Regions (page 118) with the Init Region Tool , Particle Clouds 

(page 96) with the Particle Cloud Tool , and Zones with the Zone Tool .  These tools draw axis-

aligned boxes, and so they behave similarly.  They all have the following drawing properties: 

 [X,Y, or Z] Location: The drawing plane for the tool.  When the active floor is changed, this is set 

to the floor’s elevation. 

 Height: The depth of the drawn box in the current view.  When the active floor is changed, this 

is set to the floor’s wall height. 

To draw one of these objects, perform the following: 

1. Select the appropriate tool. 

2. Use Click-drag Mode or Multi-click Mode to draw two points defining the extents of the object’s 

box. 

Editing Objects 
Nearly all geometric objects can also be graphically edited in the 3D or 2D View with the 

Select/Manipulate Tool .  

Editing is performed through an object’s editing handles. Handles appear on an object either as a blue 

dot as shown in Figure 8.26 or a face with a different color.  The dots indicate a point that can be moved 

in either two or three dimensions.  A discolored face indicates that a face can be moved or extruded 

along a line. 
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Figure 8.26. Editing handles on an object 

To graphically edit an object, perform the following: 

1. Select the Select/Manipulate Tool  from the navigation toolbar. 

2. Select one object to edit1. If the object can be graphically edited, blue editing handles will 

appear. 

3. Hover the cursor over the desired handle.  If the handle is a dot, it will turn yellow.  If the handle 

is a face, the entire face will turn yellow as shown in Figure 8.27. 

4. Move the handle using Click-drag Mode or Multi-click Mode to specify two points defining the 

movement vector. 

 

Figure 8.27. A highlighted face handle 

Transforming Objects 
PyroSim provides a variety of tools to transform geometry objects.  With the transform tools, users can 

move, rotate, and mirror objects.   

Copy Mode 

Each tool has an alternate mode to copy the source objects with the transform.  To toggle copy mode 

on/off, press the CTRL key on the keyboard.  Alternately, choose Copy Mode or Move Mode from the 

                                                           
1
 Only one object can be edited at a time. Editing handles will only appear if exactly one object is selected. 
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tool’s right-click menu.  When using copy mode, the selected objects are copied and the copies are 

transformed. 

Move Tool 

This tool allows the user to move selected objects to a new location as shown in Figure 8.28.  To use this 

tool, perform the following: 

1. Select the desired objects to move from any of the views. 

2. Select the Move Tool  from the drawing toolbar. 

3. Use Click-drag Mode or Multi-click Mode to draw two points defining the movement vector. 

 

Figure 8.28. Moving an object using the Move Tool 

Rotate Tool 

This tool allows the user to rotate selected objects as shown in Figure 8.291.  To use this tool, perform 

the following: 

1. Select the desired objects to rotate from any of the views. 

2. Select the Rotate Tool  from the drawing toolbar. 

3. Single-click to specify the rotation center.2 

4. Single-click another point to define a reference vector from the first point to the second point.  

This reference vector is what the angle is based from. 

5. Single-click a third point to define the angle vector from the first point to the third point.  The 

selected objects will be rotated by the angle between the reference and angle vectors. 

The following defines the axis about which objects are rotated for each view: 

                                                           
1
 Some objects, such as a solution mesh can only be rotated by 90 degree increments. 

2
 The rotate tool can only be performed with Multi-click Mode since it requires three reference points. 
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 3D View: Z axis 

 Top View: Z axis 

 Front View: -Y axis 

 Side View: -X axis 

  
1 2 

 
3 

Figure 8.29. Rotating an object with the Rotate Tool 

Mirror Tool 

The mirror tool allows objects to be mirrored across a plane as shown in Figure 8.301. To use the mirror 

tool, perform the following: 

1. Select the desired objects to mirror from any view. 

2. Select the Mirror Tool  from the drawing toolbar. 

3. Use Click-drag Mode or Multi-click Mode to define two points that create a plane about which 

the selected objects are mirrored. 

                                                           
1
 Some objects, such as solution meshes, can only be mirrored about an X, Y, or Z plane. 



Drawing in PyroSim 

 

75 

  
1 2 

Figure 8.30. Mirroring an object using the Mirror Tool 

Painting Obstructions and Vents 
PyroSim provides tools to paint obstructions and vents with a surface and/or color.  A user can also use 

a picking tool to pick the surface and/or color used to draw new obstructions or vents or to perform 

painting. 

Paint Tool 

A user can use the Paint Tool  to paint the faces of obstructions and vents a specific surface and/or 

color. 

The Paint Tool has the following tool properties: 

 Apply Surface: Specifies whether to paint faces with surfaces and which surface to use. 

 Apply Color: Specifies whether to paint faces with a specific color and which color to use. 

These painting options can also be cycled by pressing CTRL on the keyboard or through the tool’s right-

click menu.  The right-click menu also allows quick selection of a surface in the model or recently-used 

color. 

To paint faces with the paint tool, perform the following: 

1. Select the Paint Tool  from the drawing toolbar. 

2. Hover the cursor over the desired face to paint.  If the face can be painted with the current 

surface/color, the face with highlight yellow as shown in Figure 8.31. 

3. Either single-click the face to paint only that face, or click-drag the left mouse button to paint all 

faces the cursor moves over.  Hold SHIFT on the keyboard while painting to paint all the faces of 

the object rather than just one face. 

NOTE: A popup window will show which surface/color is currently being painted, but unlike other popup 

windows, this one is NOT editable. 
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Figure 8.31. An obstruction face highlighted by the paint tool 

Pick Tool 

The Pick Tool  can be used to pick the next color/surface to use when drawing or painting 

obstructions and vents. 

The Pick Tool has the following tool properties: 

 Pick Surface: Whether to pick the surface under the cursor 

 Pick Color: Whether to pick the color under the cursor. 

The pick options can also be toggled by pressing CTRL on the keyboard or from the tool’s right-click 

menu. 

To use the Pick Tool, perform the following: 

1. Select the Pick Tool  from the drawing toolbar. 

2. Hover the cursor over the object from which the color/surface should be chosen.  A popup 

window will show what that color/surface is. 

3. Single-click the left mouse button to pick.   

The chosen color/surface will then be applied to the surface or color properties for the obstruction, vent, 

mesh, and paint tools. 

Measuring Length/Distance 
PyroSim provides a measure tool  to measure distances in the model.  To measure a distance, 

perform the following: 

1. Select the Measure Tool . 
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2. Either click several points to measure the total distance along a path or click-drag to measure a 

single distance between two points.  As the cursor is moved, the current cursor location, total 

path length, and length of the most recent segment are displayed as shown in Figure 8.32. 

3. To copy the distance, right-click and from the menu, choose Copy total distance to clipboard.  

This will make the total distance measurement available on the clipboard so it can be pasted 

into a field or any other paste location.  The text that is copied to the clipboard includes both 

the full precision value and the current display length unit.  For example, it might copy 

“3.2808399 ft” if working in the English unit system. 

 

Figure 8.32. Information displayed by the measure tool 

NOTE: When working in the 3D View, all distances are true to the 3D snapped locations of the cursor.  In 

the 2D Views, however, the cursor locations are projected to a single plane parallel to the view before 

determining the distance.  This means that in the Top View, all Z distances are ignored.  In the Front 

View, all Y distances are ignored.  In the Side View, all X distances are ignored.
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Chapter 9. Creating Complex Geometry  
This chapter provides guidance on using the geometry tools available in PyroSim to create several 

geometric shapes that often appear in building models. The ability to sketch in different planes, copy, 

replicate, drag, scale, and rotate objects can greatly simplify the tasks of geometry creation. 

Curved Walls    
While PyroSim’s tools do not explicitly produce curved walls, they can approximate them using any of 

the following techniques: 

• Draw the wall using several straight wall segments. 

• Draw the wall using individual blocks. 

• Rotate a single object to produce the desired arc. 

In all of the following examples, we will use a background image as a pattern to draw against. While this 

is not required, it makes creating curved surfaces much easier and one of the strengths of PyroSim is 

that it allows you to sketch geometry directly on top of building design images. The background image 

we will be using is shown in Figure 9.1. 

 

Figure 9.1. Background image used for all curved wall examples 

For simplicity, we will assume that horizontal distance across the entire image is 50 feet, and we will 

place the origin of the model at the lower-left corner of the room shown in the image. The brightness of 

the image will be set to 50%. The Configure Background Image dialog shown in Figure 9.2 illustrates 

these settings. 
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Figure 9.2. Background image settings for curved wall examples 

Using the Wall Tool 

To create a curved wall section from wall segments, you can follow these steps: 

1. Click the 2D View tab, and select the Draw Wall Obstruction  tool. 

2. Turn off grid snapping. In the View menu, click Disable Grid Snapping. 

3. Position the cursor at the beginning of the curve where you want to place the first wall segment. 

4. Use Multi-click Mode to click several points along the curve.  More points will create a 

smoother curve. 

5. Right-click in the 2D View and select Finish to finish drawing the wall. 

This is the fastest way to create smooth curves in PyroSim. PyroSim will convert the curved walls to 

blocks before running the FDS simulation. While smaller segments will make the wall look better in 

PyroSim, placement of obstructions generated for FDS depends on the resolution of your mesh. Three 

different versions of a curved wall created with this technique are shown in Figure 9.3. 

   
Figure 9.3. A curved wall drawn with three different segment lengths 
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Using extremely short line segments will probably not be of any benefit unless you also use very small 

mesh cells. 

Using the Block Tool 

To create a curved wall section from blocks, you can follow these steps: 

1. Create a mesh. This example uses a 50.0 ft x 50.0 ft mesh with 1 ft mesh cells. 

2. Click the 2D View tab, and select the Block Obstruction Tool . 

3. Turn grid snapping on. If snapping is off: in the View menu, click Snap to Model Grid. 

4. Click each cell along the curved wall to place the necessary blocks. 

This technique forces you to convert the curve to blocks manually, but the advantage is you know 

exactly what geometry will be generated for FDS. If you have a high resolution mesh, it may be useful to 

drag the mouse and “paint” the curve rather than clicking individual blocks. The example curved wall is 

shown in Figure 9.4. 

 

Figure 9.4. A curved wall drawn using individual blocks 

Rotating an Object 

To create curved objects using the rotation technique, you must place an initial segment, then perform a 

rotate-copy operation about the center point of your desired curve. This process is illustrated in the 

following steps: 

Click the 2D View tab, and select the Wall Obstruction Tool . 

1. Turn off grid snapping. If snapping is on: in the View menu, click Disable Grid Snapping. 

2. Create an initial wall segment somewhere on the curve. 

3. In the Model menu, click Rotate... 

4. Select the Copy mode. 

5. Specify the necessary parameters for the rotation operation. In this example, the Number of 

Copies is 15, the Angle is 6.0 degrees, and the Base Point is: x=32.0 feet, y=16.5 feet. 

6. Click Preview to verify that the settings are correct, then click OK. 
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The curve for this example is shown in Figure 9.5. 

 

Figure 9.5. A curved wall drawn using the rotate technique 

If we would have created 60 copies instead of 15 this procedure would have created a cylinder. While 

complicated, the rotation approach is the most effective at creating complex symmetrical geometry. 

Trusses 
Trusses can be created by drawing a single truss out of slab obstructions and slab holes, then replicating 

that truss as many times as needed as shown in Figure 9.6. The following steps show how to create the 

trusses for an example roof. 

1. Click the 2D View tab 

2. On the toolbar, click the Front View  button. 

3. On the drawing toolbar, select the Slab Obstruction Tool . 

4. On the drawing toolbar, click the Tool Properties  button, and set the thickness to the desired 

thickness of the truss. 

5. Draw a triangle representing the outer boundary of the truss. 

6. On the toolbar, select the Slab Hole Tool  . 

7. Draw a triangular hole in the left half of the truss. 

8. Select the newly created hole. 

9. Select the Mirror Tool . 

10. Right click in the 2D View and select Copy Mode. 

11. Draw a line from the top vertex of the outer obstruction to the center of the bottom to define 

the mirror plane. 

12. Select the entire truss, including the outer obstruction and two holes. 

13. Open the Model menu, and click Copy/Move.... 

14. In the Translate dialog: select Copy, set Number of Copies to 4, set Offset to be 2.0 meters 

along the Y axis, and click OK. 
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Figure 9.6. Trusses created using PyroSim tools 

Roofs 
You can quickly add a roof to the model using the Slab Obstruction Tool . The following steps show 

how to add a roof to the previous truss example. 

1. Click the 2D View tab. 

2. On the view toolbar, select the front view . 

3. On the drawing toolbar, select the Slab Obstruction Tool . 

4. Draw the profile of the roof as one polygon so that it touches the trusses. 

5. On the view toolbar, select the top view . 

6. On the navigation toolbar, select the Select/Manipulate Tool . 

7. Hover the mouse over the selected roof slab until the front edge is highlighted. 

8. Single-click to begin manipulation, and move the mouse until it touches the front of the first 

truss. 

9. Single-click to end manipulation. 

10. Repeat steps 7-9 for the back edge of the roof slab to line it up with the back of the last truss. 

 The resulting roof section is shown in Figure 9.7. 
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Figure 9.7. A roof created with the slab obstruction tool 

The extruded polygon tool can be used to create obstructions with any number of boundary points 

(triangles, quads, etc). 

Stairs   
Users can create simple stairways by placing the initial stair, then using the translate-copy operation. 

This section will present a simple example to illustrate the approach. 

We will create a 10 step stairway. Each step will have a 7 inch rise (0.58 feet), and a 10 inch (0.83 feet) 

run. The stairway itself will be 24 inches (2.0 feet) wide. To keep things as simple as possible, we will 

construct the stairway in an empty model. 

1.  On the Model menu, click New Obstruction... 

2.  In the Obstruction Properties dialog, specify the min point as (0.0, 0.0, 0.0) and the 

max point as (2.0, 0.83, 0.58). 

3.  On the Model menu, click Copy/Move.... 

4.  In the Translate dialog, select Copy, set the Number of Copies to 9, set the Offset to (0.0, 

0.83, 0.58), and click OK. 

The stairway generated in this example is shown in Figure 9.8. 
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Figure 9.8. A stairway created with the replicate tool
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Chapter 10. Working with Geometry Objects 

Selection  
PyroSim relies heavily on the idea of selected objects. For almost all operations, the user first selects an 

object(s) and then changes the selected object(s). The Selection Tool  is used to select objects. 

• A left mouse click on an object in any view will select it. 

• Holding Ctrl while clicking will toggle the item in the selection, adding previously unselected 

items and removing previously selected items. 

• Holding Alt while clicking an object in the 3D View or the 2D View will select the entire group 

that the object belongs to. 

• In the Navigation View, a range of objects can be selected by clicking the first object, then 

holding Shift while clicking the last object. 

• In the 2D and 3D Views, multiple objects can be selected with the Selection Tool and a click-drag 

motion to define a selection box. 

Once objects have been selected, the user can modify the object using the menus. 

Selection can be made in any of the views using the Selection tool. Multiple objects can be selected 

using the Ctrl key or click and drag to define a box. In the Navigation View, the Shift key can be used to 

select a consecutive list of objects. 

Context Menus  
A right-click on a selection displays a context menu. This menu includes the most common options for 

working with the object. The user may also right-click on individual objects for immediate display of the 

context menu. 

Undo/Redo  
All geometric changes to the model can be undone and redone using the Undo  and Redo  buttons, 

as well as Ctrl+Z and Ctrl+Y, respectively. 

Copy/Paste  
Select an object to copy, then either use Ctrl+C or Edit->Copy to copy. Alternately, right-click on an 

object to display the context menu with Copy. 

Either use Ctrl+V or Edit->Paste to paste a copy of the object. Alternately, right-click on an object to 

display the context menu with Paste. 

Copy/Paste from Other Models 

By running two instances of PyroSim, you can copy objects from one model and paste them into a 

second model. If the copied objects rely on other properties, such as surfaces, that are not included in 

the second model, these properties will be pasted into the model when the objects are pasted. 
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Copy/Paste from Text Files 

Copy/paste can also be performed to and from text files. For example the user can select an object in 

PyroSim, open a text file, and paste the object. The text FDS representations of the object and 

dependent properties will be pasted. Alternatively, the user can copy the text from an FDS file and paste 

into PyroSim (the 3D View, 2D View, or Navigation View). The object will be added to the PyroSim model. 

An error message will be received if the pasted object depends on data that is not available in the 

PyroSim model. The user will then need to paste that information (such as surface properties) first 

before pasting the geometric object. 

Double-Click to Edit  
Double-clicking on an object opens the appropriate dialog for editing the object properties. 

Translate and Copy Dialog 
The Translate dialog can be used to both move an object and to create copies of an object, each offset in 

space.  To move an object in this manner, perform the following: 

1. Right click the object(s) to move. 

2. From the right-click menu, select Copy/Move…. 

3. This will show the Translate dialog, Figure 10.1.  

The Mode selects either the option to move only the selected object or to create copies of the object 

and move them. The Offset parameters indicate the increment to move or offset the copies. 

To preview the changes without applying them, click Preview. To apply the changes and close the dialog, 

click OK. To cancel the changes instead, click Cancel. 

 

Figure 10.1. The translate dialog 

Mirror and Copy Dialog    
The Mirror dialog can be used to mirror an object about a plane or planes. To mirror an object in this 

manner, perform the following: 
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1. Right click the object(s) to mirror. 

2. From the right-click menu, select Mirror…. 

3. This will show the Mirror dialog as in Figure 10.2.  

The Mode selects either the option to mirror only the selected object or to create a mirrored copy of the 

object. The Mirror Plane(s) define planes normal to the X, Y, and Z axes about which the object will be 

mirrored. The Use Center button can be used to fill the Mirror Plane data with the center coordinates of 

the selected objects. 

To preview the changes without applying them, click Preview. To apply the changes and close the dialog, 

click OK. To cancel the changes instead, click Cancel. 

 

Figure 10.2. The mirror dialog 

Scale and Copy Dialog    
The Scale dialog can be used to change the size of an object. To scale an object, perform the following: 

1. Right click the object(s) to scale. 

2. From the right-click menu, select Scale…. 

3. This will show the Scale dialog as in Figure 10.3.  

The Mode selects either the option to scale only the selected object or to create multiple scaled copies 

of the object. The Scale values define the scale factors in the X, Y, and Z directions. The Base Point 

defines the point about which the scaling will be performed. The Use Center button can be used to fill 

the Base Point data with the center coordinates of the selected objects. 

To preview the changes without applying them, click Preview. To apply the changes and close the dialog, 

click OK. To cancel the changes instead, click Cancel. 
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Figure 10.3. The scale dialog being used to scale an object 

Rotate and Copy Dialog    
The Rotate dialog can be used to rotate an object. To rotate an object, perform the following: 

1. Right click the object(s) to rotate. 

2. From the right-click menu, select Rotate… 

3. This will show the Rotate dialog as in Figure 10.4.  

The Mode selects either the option to rotate only the selected object or to create multiple rotated 

copies of the object. The Rotation values allow the user to select the axis about which the rotation will 

be made and the angle is the rotation angle (counter-clockwise is positive). The Base Point defines the 

point about which the rotation will be performed. The Use Center button can be used to fill the Base 

Point data with the center coordinates of the selected objects. 

To preview the changes without applying them, click Preview. To apply the changes and close the dialog, 

click OK. To cancel the changes instead, click Cancel. 
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Figure 10.4. The rotate dialog being used to rotate an object 

Object Visibility 
Often it is desirable to turn off the display of selected objects, for example, to hide a roof of a building in 

order to visualize the interior. In any of the views, right-click on a selection to obtain the following 

options: 

• Hide object(s) - This turns off the display of the selected object(s). 

• Show object(s) - This turns on the display of the selected object(s). 

• Filter object(s) - This turns off the display of all objects except the selection(s). 

• Show all objects - Turns on the display of all objects.
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Chapter 11. Reactions  
This chapter provides an overview of how to specify combustion (the reaction of fuel vapor and oxygen) 

using PyroSim. A more detailed discussion of this topic is provided in the Fire Dynamics Simulator User’s 

Guide(McGrattan, et al., 2007) and the Fire Dynamics Simulator Technical Reference Guide(McGrattan, 

et al., 2007). 

As described in the Fire Dynamics Simulator User’s Guide (McGrattan, et al., 2005), a common source of 

confusion in FDS is the distinction between gas phase combustion and solid phase pyrolysis. The former 

refers to the reaction of fuel vapor and oxygen; the latter the generation of fuel vapor at a solid or liquid 

surface. In an FDS fire simulation, there is only one gaseous fuel that acts as a surrogate for all the 

potential fuel sources. The reaction is defined using the Edit Reactions dialog in PyroSim. 

The PyroSim interface supports only the mixture fraction model to account for the evolution of the fuel 

gas from its surface of origin through the combustion process. The alternative provided in FDS5 is the 

finite-rate approach, where all of the individual gas species involved in the combustion process are 

defined and tracked individually. This finite-rate approach is recommended only for Direct Numerical 

Simulation. The mixture fraction model is the most frequently used approach. 

Mixture Fraction Combustion 
In FDS, there are two ways of designating a fire: the first is to specify a Heat Release Rate Per Unit Area 

(HRRPUA) as part of a surface, the other is to specify a HEAT_OF_REACTION, along with other thermal 

parameters, as part of a material. In both cases, the mixture fraction combustion model is used. 

The heat release rate approach is the simplest way to specify a fire. All that needs to be done is create a 

burner surface with the desired heat release rate (see Chapter 6). If no other reaction is specified, 

propane will be used as the surrogate fuel. If a reaction is specified, that reaction will be used to 

calculate the combustion products. 

In the mixture fraction model, the reaction is assumed to be of the form: 

 

Figure 11.1. Reaction equation 

The user specifies the chemical formula of the fuel along with the yields of CO, soot, and H2, and the 

amount of hydrogen in the soot. For completeness you can specify the N2 content of the fuel and the 

presence of other species. 

To edit a reaction: 

1. On the Model menu, click Edit Reactions.... 
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2. On the Fuel tab, enter the number of atoms in the reaction equation. The input for an ethanol 

reaction as defined in the ethanol_pan.fds example distributed with FDS5, is shown in Figure 

11.2. The fuel is defined by 2 carbon atoms, 6 hydrogen atoms, and 1 oxygen atom. 

3. If desired, change the default values for the Ambient Oxygen Mass Fraction (Y_O2_INFTY), the 

Mass Fraction of Fuel in Burner (Y_F_INLET), and the Upper limit of flame heat release rate 

(HRRPUA_SHEET). 

4. On the Fire Suppression tab, you can enable fire suppression and then enter values for the 

Limiting Oxygen Index (X_O2_LL) and the Critical Flame Temperature 

(CRITICAL_FLAME_TEMPERATURE). The default values are shown in Figure 11.3. 

5. On the Byproducts tab, you can select either Specify release per unit mass oxygen (EPUMO2) or 

specify heat of combustion (HEAT_OF_COMBUSTION). You can also specify the CO yield, H2 

yield, and Soot yield. The values used for the ethanol pan fire are shown in Figure 11.4. 

6. On the Soot tab, you can define the fraction of the atoms in the soot that are hydrogen, 

Hydrogen Fraction (SOOT_H_FRACTION) and the parameters that control visibility. See Chapter 

12 of the Fire Dynamics Simulator User’s Guide (McGrattan, et al., 2007). The default values are 

shown in Figure 11.5. 

 

 

Figure 11.2. Fuel panel of the Edit Reactions dialog 
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Figure 11.3. Fire Suppression panel of the Edit Reactions dialog 

 

Figure 11.4. Byproducts panel of the Edit Reactions dialog 

 

Figure 11.5. Soot panel of the Edit Reactions dialog 
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Extra Species 
Extra Species are used to introduce non-reacting gases into the domain. These gases are tracked 

separately from the mixture fraction by FDS. In addition, they can have an initial concentration in the 

domain and can be injected into the domain by appropriate surfaces. 

Extra Species can be managed by opening the Model menu and selecting Edit Extra Species.... To create 

a new species, select New. Either select one of the predefined species or create a custom species. If a 

predefined species is selected, only the initial mass fraction of the species in the domain can be edited. 

If a custom species is created, the molecular weight must be specified. If running a DNS simulation, 

Leonard-Jones and alternate parameters may also be specified. 

Once extra species are prescribed, they can be injected into the domain by Supply and Layered surfaces 

as discussed in Supply and Layered. They can be tracked by gas-phase devices, output slices, isosurfaces, 

Plot3D output, and statistics. 

Custom Smoke 
PyroSim supports the custom smoke features available in FDS. To create custom smoke, first define an 

extra species with the desired mass extinction coefficient. This “smoke” species can then be injected 

into the domain like any other extra species. Smoke detectors can also detect this smoke species if it is 

selected under the smoke detector’s model, which can be edited under Edit Smoke Detector Models... 

on the Devices menu. Finally, if Smokeview should track this species as smoke, go to the FDS menu, 

select Simulation Parameters..., and on the Output tab select the mass fraction quantity of the desired 

species from the Smoke Quantity drop-down box. Note that in addition to specifying the mass fraction 

of an extra species, the mass fraction of any mixture fraction species can also be selected for smoke 

display, including the mass fraction of oxygen, water vapor, and the other species specified in the gas-

phase reaction.



Particles 

 

94 

Chapter 12. Particles  
PyroSim supports four types of particles: massless tracers, water droplets, fuel droplets, and a generic 

particle that provides the same options as water droplets. 

Massless Tracers 
Massless tracer particles can be used to track air flow within a simulation. They can be used with the 

particle injection feature of the Burner, Heater/Cooler, Blower, and Layered surface types. They can 

also be used in particle clouds. 

By default, PyroSim provides a black, massless tracer particle called Tracer. To use a custom tracer 

particle in your simulation, you can modify the parameters of this default particle to suit your needs, or 

you can create a new particle. To create a new massless tracer particle: 

1. On the Model menu, click Edit Particles... 

2. Click New... 

3. In the Particle Type box, select Massless Tracer 

4. Click OK 

You can now edit the particle properties. 

Parameter Description 

Duration The amount of time a droplet of this type will remain in the 
simulation. 

Insertion Interval The amount of time between droplet insertions. 

Sampling Factor Sampling factor for the particle output file. A value of -1 
uses the FDS default value for this property. Set to an integer 
greater than 1 to reduce the size of particle output. 

Water Droplets 
Water droplets can be used with sprinkler spray models and nozzles to customize the spray. They can 

also be used in particle clouds and surface types that support particle injection. 

By default, PyroSim provides a water particle called Water that has all of the common properties of 

water. To use a custom water droplet in your simulation, you can modify the default water definition to 

suit your needs or you can create a new droplet type by clicking New.... 

Water droplets support the following Thermal Properties: 

Parameter Description 

Initial Temperature The initial droplet temperature. 

Density The droplet density. 

Specific Heat The droplet specific heat. 
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Pyrolysis: 

Parameter Description 

Melting Temperature The droplet melting/freezing temperature. 

Vaporization Temperature The droplet liquid boiling temperature. 

Heat of Vaporization The droplet latent heat of vaporization. 

 

Coloring: 

Parameter Description 

Default Select to FDS to select a color for this particle. 

Specify Select to choose a custom particle color. 

By Droplet Property Select this option to choose one or more scalar quantities 
that will be used to color this particle in Smokeview. 

 

Size Distribution: 

Parameter Description 

Median Diameter The median volumetric diameter of each droplet. 

Constant Use a constant diameter for each droplet. 

Rosin-Rammler Rather than use a constant diameter for each droplet, allow 
each to be sized according to a combination of Rosin-
Rammler and log-normal. 

Distribution (gamma) The width of the distribution. The larger the value of gamma, 
the narrower the droplet size is distributed about the median 
value. 

Minimum Diameter Droplets smaller than the minimum diameter are assumed to 
evaporate in a single time step. 

Maximum Diameter Droplets larger than the maximum diameter are assumed to 
break up in a single time step. 

 

Injection: 

Parameter Description 

Droplets per Second The number of sprinkler droplets inserted every second per 
active sprinkler. This parameter only affects sprinkler 
droplets. 

Duration The amount of time a water droplet will remain in the 
simulation. 

Insertion Interval The amount of time between droplet insertions. 
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Parameter Description 

Sampling Factor Sampling factor for the particle output file. A value of -1 uses 
the FDS default value for this property. Set to an integer 
greater than 1 to reduce the size of particle output. 

Fuel Droplets 
Fuel droplets can be used with sprinkler spray models and nozzles to customize the spray. They can also 

be used in particle clouds and surface types that support particle injection. Fuel droplets are initially 

burning and do not require an ignition source. 

By default, PyroSim provides a fuel droplet type called Fuel. To use a custom fuel droplet, you can 

modify the default fuel definition to suit your needs, or you can create a new droplet type by clicking 

New.... 

The parameters for fuel droplets are identical to the options for water droplets with one exception. Fuel 

droplets have a Heat of Combustion pyrolysis option. This option lets you specify the heat of 

combustion of the liquid fuel. 

Activation 
Normally, the insertion of particles into the domain is controlled by the surface or object emitting them, 

such as by a fan or supply surface or a particle cloud.  Alternatively, the insertion of particles can be 

controlled by a device or other control logic.  For more information on controls, see Chapter 14. 

Global Parameters 
There are two global options relating to particles in the Simulation Parameters dialog. The first option, 

Droplets Disappear at Floor, can be used to prevent droplets from gathering on the floor of the 

simulation area. The default value for this option is ON. The second option, Max Particles per Mesh, can 

be used to set an upper limit on the number of particles allowed in any simulation mesh. 

Particle Clouds 
Particle Clouds are box-shaped volumes that can be filled with particles at the start of the FDS 

simulation or be inserted periodically. To create a particle cloud, on the Model menu, click New Particle 

Cloud….  This will show the particle cloud dialog as in Figure 12.1. 
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Figure 12.1. Particle Cloud dialog 

Particle clouds have the following properties: 

 Particle: The particle to insert in the volume. 

 Insertion: How the particles are inserted in the volume. 

o Insert Once: Inserts the particles once at the beginning of the simulation. 

o Insert Periodically: Inserts particles at an interval throughout the entire simulation. 

o Mass Per Volume: The total density of the particles in the volume.  This independent of 

the particle density, which is specified per particle type. 

 Movement: How the particles move in the volume. 

o Particles Can Move: Allows particles to move in the volume. 

o Particles Are Stationary: Particles remain stationary and act as obstructions to flow. 

 Droplet Count: Controls the number of particles in the volume. 

o Density: Species the particle count as a density. 

o Constant: Species a constant number of particles. 

The geometry properties, including the size and location of the volume can be specified on the 

Geometry tab. 

Press OK to create the new particle cloud.  It will appear as a transparent box in the 3D and 2D Views.
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Chapter 13. Devices  
Devices are used to record entities in the model or to represent more complex sensors, such as smoke 

detectors, sprinklers, and thermocouples. You can make time history plots of device output in PyroSim 

by opening the CHID_devc.csv file. 

Devices can be moved, copied, rotated, and scaled using the tools described in Chapter 10 on page 85. 

Most often, the user will simply select one or more devices, right-click to display the context menu, and 

click Copy/Move. By copying a single device along a line and then copying the line in the normal 

direction, it is possible to quickly define an array of devices. 

After a device is defined, it can be used to activate an object. The value that triggers the activation 

(setpoint) is defined in the same dialog as the device. This is discussed more in Chapter 14. 

Aspiration Detection System 
An aspiration detection system groups together a series of soot measurement devices. An aspiration 

system consists of a sampling pipe network that draws air from a series of locations to a central point 

where an obscuration measurement is made. To define such a system in FDS, you must provide the 

sampling locations, sampling flow rates, the transport time from each sampling location, and if an alarm 

output is desired, the overall obscuration setpoint. 

To define the soot measurement devices: 

1. On the Devices menu, click New Aspirator Sampler.... 

2. Enter the Name and Location of the sampler. 

3. Click OK to create the sampler. 

To define the aspiration detection system: 

1. On the Devices menu, click New Aspirator.... 

2. Give the Name and select which Aspirator Samplers will be included. For each sampler, provide 

the data described below. 

3. Click OK to create the aspirator detector. 

Supply the following information for the aspiration detection system, Figure 13.1. 

Parameter Description 

Aspirator Name The name of the aspiration detection system. 

Bypass Flow Rate The flow rate of any air drawn into the system from outside 
the computational domain. 

Transfer Delay The transport time from the sampling location to the central 
detector. 

Flowrate The gas flow rate. 
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Parameter Description 

Location The coordinates of the aspiration detection system. 

Orientation Not used. 

Rotation Not used. 

 

 

Figure 13.1. Creating an aspirator sampler 

The output of the aspiration detection system will be the combined obscuration. 

Gas or Solid Phase Device 
Simple gas phase and solid phase devices can be used to measure parameters in the gas or solid phase. 

To define a measurement device: 

1. On the Devices menu, click New Gas-phase Device... or New Solid-phase Device... . 

2. Enter the Name of the device. 

3. Select the Quantity to be measured. 

4. Enter the Location of the device. For solid-phase devices, position the device on a surface. 

5. Enter the Normal of Solid of the device. For solid-phase devices, this is the outward normal to 

the surface on which the device is attached. 

6. The Rotation can be left as 0. 

7. Click OK to create the device. 
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Thermocouple 
To create a thermocouple, on the Devices menu, click New Thermocouple.... 

The thermocouple properties are: 

Parameter Description 

Device Name The name of the thermocouple. 

Bead Diameter The bead diameter of the thermocouple. 

Emissivity The emissivity of the thermocouple. 

Bead Density The material density of the bead. The default value is that for 
nickel. 

Bead Specific Heat The material specific heat of the bead. The default value is 
that for nickel. 

Location The coordinates of the device. 

Orientation Not used. 

Rotation Not used. 

 

The output of the thermocouple is the temperature of the thermocouple itself, which is usually close to 

the gas temperature, but not always, since radiation is included in the calculation of thermocouple 

temperature. 

Flow Measurement 
The flow measurement device can be used to measure a flow quantity through an area. To create a flow 

measuring device, on the Devices menu, click New Flow Measuring Device.... 

The flow measurement device properties are: 

Parameter Description 

Device Name The name of the flow measuring device. 

Quantity The quantity to be measured. 

Flow Direction Select the direction for the measurement as defined by the 
normal to the measurement plane. 

Plane The axis normal to the measurement plane and the location 
of that plane on the axis. 

Bounds The coordinates of the area normal to the axis. 

 

The output will be the total flow through the defined area. 

Heat Release Rate Device 
The heat release rate device measures the heat release rate within a volume. To define a heat release 

rate device, on the Devices menu, click New Heat Release Rate Device.... 
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The heat release rate device properties are: 

Parameter Description 

Device Name The name of the heat release rate device. 

Bounds The coordinates of the volume within which to calculate the 
heat release rate. 

 

The output will be the total heat release rate within the volume. 

Layer Zoning Device 
There is often the need to estimate the location of the interface between the hot, smoke-laden upper 

layer and the cooler lower layer in a burning compartment. Relatively simple fire models, often referred 

to as two-zone models, compute this quantity directly, along with the average temperature of the upper 

and lower layers. In a computational fluid dynamics (CFD) model like FDS, there are not two distinct 

zones, but rather a continuous profile of temperature. FDS uses an algorithm based on integration along 

a line to estimate the layer height and the average upper and lower layer temperatures. To define a 

layer zoning device, on the Devices menu, click New Layer Zoning Device.... 

The layer zoning device properties are: 

Parameter Description 

Device Name The name of the layer zoning device. 

Measure Layer Height Enables measurement of the layer height. 

Measure Upper Temperature Enables measurement of the upper layer temperature. 

Measure Lower Temperature Enables measurement of the lower layer temperature. 

Path The coordinates of the end points of a line along which the 
layer height will be calculated. The two endpoints must lie in 
the same mesh. 

 

The output will be the quantities selected. 

Path Obscuration (Beam Detector) Device 
A beam detector measures the total obscuration between points. To define a beam detector device, on 

the Devices menu, click New Path Obscuration Device.... 

The path obscuration device properties are: 

Parameter Description 

Device Name The name of the path obscuration device. 

Path The coordinates of the end points of a line along which the 
obscuration will be calculated. The two endpoints must lie in 
the same mesh. 
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The output will be the percent obscuration along the path. 

Heat Detector 
A heat detector measures the temperature at a location using a Response Time Index model. To define a 

heat detector device, on the Devices menu, click New Heat Detector.... 

The heat detector device properties are: 

Parameter Description 

Device Name The name of the heat detector. 

Link The link defines the activation temperature and the response 
time index. 

Location The coordinates of the device. 

Orientation Not used. 

Rotation Not used. 

 

The output will be the heat detector temperature. 

Smoke Detector 
A smoke detector measures obscuration at a point with two characteristic fill-in or “lag” times. To define 

a smoke detector, on the Devices menu, click New Smoke Detector.... 

The smoke detector device properties are: 

Parameter Description 

Detector Name The name of the smoke detector. 

Model Select the smoke detector type. You can edit the smoke 
detector parameters to create a new type. 

Location The coordinates of the device. 

Orientation Not used. 

Rotation Not used. 

 

The output will be the percent obscuration per meter. 

Sprinkler 
Sprinklers can spray water or fuel into the model. To define a sprinkler: 

1. On the Devices menu, click New Sprinkler.... This will display the Sprinkler dialog, Figure 13.2. 

2. Select the desired options and define required input parameters as described below. 

3. Click OK to create the sprinkler. 
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Figure 13.2. Creating a new sprinkler 

The sprinkler properties are: 

Parameter Description 

Sprinkler Name The name of the sprinkler. 

Spray Model The spray model defines the particle type (water and fuel are 
default options), the flow rate, and the jet stream shape. 

Dry Pipe In a dry pipe sprinkler system, the normally dry sprinkler 
pipes are pressurized with gas. When a link activates in a 
sprinkler head, the pressure drop allows water to flow into 
the pipe network. You can create a dry pipe and edit the 
delay. 

Activator By default the sprinkler is activated by a temperature link, 
with a response time index. You can edit the activation 
temperature and the response time index. Alternately, you 
can select a more general quantity to activate the sprinkler. 
By default the sprinkler is initially not active and is triggered 
only once. 

Location The coordinates of the sprinkler. 

Orientation The components of the direction vector. 

Rotation Normally not used for a sprinkler. It could be used to rotate a 
spray pattern that varies with latitude (circumferentially). 

 

Nozzle  
Nozzles are very much like sprinklers, only they do not activate based on the standard RTI model. The 

can be set to activate by custom control logic.
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Chapter 14. Control Logic   
Objects can be set to activate or deactivate during the simulation using activation events. Activation 

events are the control logic system in FDS and can be set on each geometric simulation object (e.g. walls, 

holes, vents) using the Activation option in the object’s Properties dialog. PyroSim supports activation 

events based on time and input devices. Some uses of activation events include: 

• Causing a door obstruction to be removed (i.e. opened) from the simulation at a particular time, 

• Causing a window obstruction to be removed (i.e. break) when a heat detector triggers, and 

• Causing a ventilation system to activate when any of several smoke detectors activates 

To open the Activation Controls dialog (shown in Figure 14.1): On the Devices menu, click Edit 

Activation Controls.... 

 

Figure 14.1. The Activation Controls dialog 

Creating Activation Controls 
Creating controls in PyroSim takes 3 steps: 

1. Select an input type (time, detector, deadband, or custom). This is the source of the signal that 

will trigger the control. 

2. Choose an action to perform (e.g. create an object). 

3. Set specific inputs for the control based on a pattern created by steps 1 and 2. 
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After selecting an input type and an action, a pattern (in sentence form) for describing the control logic 

will appear in the dialog. Some key words and numbers will be drawn in blue and underlined. Any blue 

text can be clicked to modify the behavior of the specific control. 

Figure 14.2 shows the selector popup for objects. Objects are selected by name. To quickly find objects 

in the selector popup, you can type the first few letters of the object’s name. 

 

Figure 14.2. The object popup in the Activation Controls dialog 

Activation controls are stored separately from specific geometric objects. This makes it possible to bind 

an object to a control after it has been created. You can use the Activation box in an object’s properties 

editor to bind that object to an existing activation control, or even create a new control directly. Figure 

14.3 shows the activation control in the object properties dialog for a hole. 
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Figure 14.3. The Activation Controls dialog 

Once a control has been bound to an object (or objects) any objects linked to that control will show a 

text description of the control in their properties editor. This text will be shown in blue and underlined 

and can be clicked to edit the activation control. Changes made to the activation control will impact all 

referencing objects. 

Time-based Input 
To create or remove an object at a specific time, select Time for the Input Type in the Activation 

Controls dialog. When using time as the input, objects can be created at a specific time, removed at a 

specific time, or be created and removed periodically throughout the simulation. To create or remove 

the objects once, select Create/Activate or Remove/Deactivate under the Action to Perform. To 

create/remove the object periodically, select Multiple under the Action to Perform. When performing 

multiple timed events, the creation and removal and times at which they occur are specified in the table 

at the bottom of the dialog. The create and remove events should alternate as time increases. 

Detector-based Input 
To create or remove some objects based on a device in the model, the device must first have a setpoint 

enabled. To specify a setpoint, perform the following: 

1. Create a new device or open the properties for an existing device. 

2. Check the box next to Enable Setpoint: 

3. Enter the desired value at which the device will trip. 

4. Choose the options for the detector: 

• Trigger only once - the detector will only trigger once at the setpoint during the entire 

simulation. 

• Initially activated - if this is unchecked, the detector is untriggered at the start of the 

simulation and will turn on when the setpoint is reached for the first time. If this is 
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checked, the detector is triggered at the start and will turn off when the setpoint is 

reached. 

5. Click OK to close the device dialog. 

Once the desired devices have been given a setpoint, they can be used as inputs to the control logic 

expression. Now in the Activation Controls dialog, select Detector as the Input Type. The detector can 

be used to Create/Activate or Remove/Deactivate the desired objects when the detector either 

activates or deactivates. If more than one detector is to be used to activate the objects, the descriptive 

sentence can be used to decide if the objects should trigger when any, all, or a certain number of the 

devices activate.
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Chapter 15. Output Controls  
In this chapter we describe the simulation output options available in PyroSim. Each of these options is 

located in the Output menu. 

Solid Profiles 
Solid profiles measure quantities (e.g. temperature, density) as they extend into solid objects. The 

output file for this measurement device will be named CHID_prof_n where CHID is the job ID and n 

is the index of the solid profile. This output file contains the data necessary to create an animated 2D 

chart of the quantity as it extends into the object over time. PyroSim does not currently support 

displaying this output file. 

To generate solid profile output, on the Output menu, click Solid Profiles.... Each solid profile requires 

the following parameters: 

Parameter Description 

ID The name of this solid profile entry. 

X, Y, Z The coordinates of a point on the face that will be examined by this 
solid profile. 

ORIENT The direction of the face that will be examined by this solid profile. To 
generate solid profile output for the top of an object, this value will 
be Z+. This parameter prevents any ambiguity that might result from 
a point that lies on two adjoining faces. 

QUANTITY The quantity that will be measured in this solid profile. 

Note 

The surface to be measured must be heat-conducting. If the surface on the specified face is not heat-

conducting, FDS will issue an error and exit before running the simulation. 

Slices   
Slices or slice planes measure gas-phase data (e.g. pressure, velocity, temperature) on an axis-aligned 

plane. This data can then be animated and displayed using Smokeview (Figure 15.1). 
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Figure 15.1. An example of a slice plane shown in Smokeview. 

To generate animated slice planes, on the Output menu, click Slices.... Each slice plane requires the 

following parameters: 

Parameter Description 

XYZ Plane The axis (X, Y, or Z) along which to place the slice plane. 

Plane Value The value along the specified axis where the plane will be placed. 

Gas Phase Quantity The quantity that this plane will measure. This list includes built-in 
options such as temperature as well as dynamic options such as those 
base on particles. 

Use Vector? Setting this option to YES will cause FDS to generate additional flow 
vector data for this slice. 

 

Slice files may be viewed in Smokeview by selecting Load/Unload->Slice file. To view the vector 

representation, select Load/Unload->Vector slices. 

Boundary Quantities   
Boundary quantities provide a way to visualize output quantities (e.g. temperature) on the walls of 

every obstruction in the simulation. This data can be animated and visualized in Smokeview (Figure 15.2). 

Since the data applies to all surfaces in the simulation, no geometric data needs to be specified. 
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Figure 15.2. An example of a boundary quantity shown in Smokeview 

To generate boundary quantity data, on the Output menu, click Boundary Quantities.... In the 

Animated Boundary Quantities dialog, you can select each quantity you would like to be available for 

visualization. 

To view boundary data in Smokeview (e.g. wall temperature), right-click to open the menu, then select: 

Load/Unload->Boundary File->WALL_TEMPERATURE. 

Isosurfaces   
Isosurfaces are used to plot the three dimensional contour of gas phase quantities. This data can be 

animated and visualized in Smokeview (Figure 15.3). 
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Figure 15.3. An example of an isosurface shown in Smokeview 

To generate isosurface data, on the Output menu, click Isosurfaces.... In the Animated Isosurfaces 

dialog, you can select each quantity you would like to be available for visualization. Then you must enter 

values at which to display that quantity in the Contour Values column. If you enter more than one 

contour value, each value must be separated by the semi-colon character (;). Once you have finished 

typing the value, press enter. 

To view isosurface data in Smokeview, right-click to open the menu, then select: Load/Unload-

>Isosurface File->TEMPERATURE. 

Plot3D Data   
Plot3D is standard file format and can be used to display 2D contours, vector plots, and isosurfaces in 

Smokeview (Figure 15.4). 
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Figure 15.4. A velocity Plot3D data shown in Smokeview 

By default, Plot3D data will be generated for the following quantities: Heat Release Rate per Unit 

Volume (HRRPUV), Temperature, U-Velocity, V-Velocity, and W-Velocity. To change the Plot3D output 

quantities, on the Output menu, click Plot3D Data.... In the Plot 3D Static Data Dumps dialog, select the 

output quantities to generate. Since FDS supports a maximum of five Plot3D output quantities, you must 

remove some existing quantities to add new ones. 

Statistics   
Statistics output is an extension of the devices system. You can insert a statistics gathering device and it 

will output data about the minimum, maximum, and average value of a particular quantity in one or 

more mesh. This data can then be viewed in a 2D chart using PyroSim (Figure 15.5). 
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Figure 15.5. An example of statistic output 

To generate statistics data for some region, on the Output menu, click Statistics..., then click New.... 

Once a quantity is selected, some combination of the following options is available depending on 

whether the quantity is gas or solid-phase and what units are output by the quantity: 

Parameter Description 

Quantity The quantity that will be measured. This value is set when you 
create the statistics entry and cannot be modified. 

Mean Select this option to output the average value of the measured 
quantity over time in a mesh. 

Minimum Select this option to output the minimum value of the measured 
quantity over time in a mesh. 

Maximum Select this option to output the maximum value of the measured 
quantity over time in a mesh. 

Volume Mean This option is available for gas-phase quantities only. It is similar 
to “Mean,” but each cell value is weighted according to its relative 
size. 

Mass Mean This option is available for gas-phase quantities only. It is similar 
to “Mean,” but each cell value is weighted according to its relative 
mass. 

Volume Integral This option is available for gas-phase quantities whose units 
involve m-3, such as heat release rate per unit volume. 

Area Integral This option is available for gas-phase quantities whose units 
involve m-2. If this option is selected, a recording area rather than 
a recording volume must be defined. 

Surface Integral This option is available for solid-phase quantities whose units 
involve m-2, such as heat and mass fluxes. 

Recording Volume This is available for gas-phase quantities as long as the Area 
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Parameter Description 

Integral option is not selected. This defines a volume over which 
the statistics will be taken. 

Recording Area This is available for gas-phase quantities if the Area Integral 
option is selected. This defines an area over which the statistics 
will be taken. 

Recording Mesh This is available for solid-phase quantities. Select the mesh for 
which you would like to output this statistical data. A proper 
location will automatically be chosen for the device in the FDS 
output file. 

 

The output file for measurement devices will be named CHID_devc.csv where CHID is the job ID. 

Note 

When using statistics data, it is important to consider nuances of FDS’s numerical solver. For instance, 

the minimum statistic is sensitive to numerical errors in the solver during species transport and will 

sometimes report artificially low values.
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Chapter 16. Evac  
FDS contains an evacuation model that makes it possible to perform a coupled fire and evacuation 

simulation. Documentation relating specifically to FDS+EVAC is not included with PyroSim. To learn 

more, please visit the FDS+EVAC web site at: http://www.vtt.fi/proj/fdsevac/index.jsp 

PyroSim supports FDS+EVAC by optionally activating user interface controls in the MESH editor as 

well as the geometric object (obstructions, holes, vents) editors. Also, for each FDS+EVAC namelist, 

PyroSim provides a manager dialog in the Evac menu. 

When FDS+EVAC support is enabled, the Evac menu options will be enabled, the FDS+EVAC UI 

components will be present in the MESH and object editors, and FDS+EVAC options will be included 

with any FDS input files generated by PyroSim - as seen in the record view, when exporting FDS input 

files, and when running simulations. When FDS+EVAC support is disabled, the Evac menu options will 

be disabled, FDS+EVAC UI components will not be present in the MESH and object editors, and 

FDS+EVAC namelists will be excluded from any FDS input files generated by PyroSim. FDS+EVAC 

options within MESH, OBST, HOLE, and VENT records will continue to be written to prevent 

modification of the fire model. Disabling FDS+EVAC within PyroSim does not cause FDS+EVAC data 

to be lost, this data will remain unchanged until FDS+EVAC is enabled again. 

Using FDS+EVAC 
By default, options relating to FDS+EVAC are disabled in PyroSim. If you load a model that uses 

FDS+EVAC features or if you import an FDS file that contains FDS+EVAC records, PyroSim will 

automatically activate the FDS+EVAC features. To manually activate FDS+EVAC support in PyroSim: 

• On the Evac menu, click Enable FDS+EVAC 

FDS+EVAC works by establishing flow fields using special 2D evacuation-specific meshes and low-

powered intake vents at the building exits. To run the evacuation model with a fire model you must: 

• Define new meshes that will be used specifically for the evacuation simulation. For these 

meshes, the Evacuation box must be checked. 

• Define an exhaust (outflow) surface used to create the evacuation flow field. The FDS+EVAC 

manual recommends this surface have a velocity of 1.0e-6 m/s and a ramp time of 0.1 s 

using a Tanh curve. 

• Place vents at the exit and door locations and assign to them the outflow surface. Using the Evac 

tab in the vent editor, specify that the vents will be used in the evac simulation only. This will 

prevent the vents from influencing the fire model. Because vents must be placed against solid 

objects, it may be necessary to back these vents with an evac-only obstruction. 

• Create the DOOR and EXIT objects using the editors available on the Evac menu. Usually these 

will be placed in the same location as the evacuation exhaust vents. 

• Add occupants to the simulation using the Initial Positions dialog available on the Evac menu. 

http://www.vtt.fi/proj/fdsevac/index.jsp
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To take advantage of the EVAC (Initial Positions) feature that limits known exits, it is necessary to create 

an evacuation mesh for each exit. This secondary mesh must be attached to the alternate exit vent, 

allowing it to receive an alternate flow field. This field will then be used by occupants that select the 

alternate exit. 

Where to Find FDS+EVAC Records in PyroSim 
PyroSim supports all the FDS+EVAC namelists and parameters given in the FDS+EVAC Users Guide (FDS 

v5.3.1, EVAC v2.1.2). This section shows how the PyroSim dialogs relate to the FDS input records. 

FDS+EVAC uses several inputs that should only defined once in the input file. This global data includes 

FDS+EVAC entries on the TIME and MISC namelist groups as well as global data that is defined using a 

PERS namelist. This data can be edited in PyroSim using the Evac Properties dialog. 

The EVACUATION, EVAC_HUMANS, and MESH_ID records associated with MESH, OBST, HOLE, and VENT 

records can be edited using the usual editor for that record. The controls used to edit these parameters 

will not be available when the FDS+EVAC mode is disabled. 

The FDS+EVAC-specific namelists can be edited by selecting the corresponding option on the Evac menu. 

The mapping for these dialogs is shown below. 

PyroSim Dialog FDS+EVAC 
Namelist 

Person Types PERS 

Initial Positions EVAC 

Evac Holes EVHO 

Exits EXIT 

Entrances ENTR 

Doors DOOR 

Corridors CORR 

Incline/Stairs EVSS 

 

When viewing the descriptive text for a user interface element in PyroSim, you can learn the specific 

FDS+EVAC parameter by moving the mouse pointer over the text. The popup text will show the 

FDS+EVAC record name. 

For detailed information on all of the FDS+EVAC parameters, please refer to the FDS+EVAC users guide.
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Chapter 17. Running the Simulation 
All aspects of running an FDS simulation can be performed through the PyroSim user interface, including 

setting up simulation parameters, executing single- and multi-threaded simulations, running a remote 

cluster simulation, and resuming previously stopped simulations. 

Simulation Parameters 
Before running a simulation, FDS simulation parameters should be adjusted to fit the problem.  This can 

include parameters such as simulation time, output quantities, environmental parameters, conversion 

of angled geometry to blocks, and miscellaneous simulator values. 

To edit the simulation parameters, on the FDS menu, select Simulation Parameters….  This shows the 

simulation parameters dialog.  The parameters are split into several categories, with each category on 

another tab of the dialog. 

Time 

All time-related values can be entered on the Time tab as shown in Figure 17.1. 

 

Figure 17.1. Time tab of the simulation parameters dialog 

 Start Time: a remapping of simulation time, t=0, to a different time.  This is used to format the 

output time, and can be useful for recreation scenarios. 

 End Time: the ending simulation time. 

 Initial Time Step: Overrides the default time step. 

 Do not allow time step changes: Prevents FDS from dynamically altering the time step. 

 Do not allow time step to exceed initial: Prevents FDS from allowing the time step to go above 

the initial time step.  

Output 

The Output tab provides fine-grained control of how output values are recorded. 
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Figure 17.2. Output tab of the simulation parameters dialog 

 Enable 3D Smoke Visualization: whether to show smoke in the results.  If enabled, the 

visualization can be based on various species in the model. 

 Limit Text Output to 255 Columns: Limits how many columns are written to CSV output files. 

 Output File Write Intervals: Specifies intervals at which to write to various output files. 

Environment 

The Environment tab enables various ambient environmental properties to be set as shown in Figure 

17.3 
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Figure 17.3. Environment tab of the simulation parameters dialog 

A unique aspect of this tab is the specification feature for gravity.  Gravity, in each of the X, Y, and Z 

directions, can be defined as a ramped function.  This allows users to model complex behavior of gravity 

in tunnel or space applications where spatial or temporal variations in direction may change the 

magnitude vector.  Each ramp can be set to vary as a function of either the position along the X direction, 

or time. 

While this tab provides control over default environmental conditions, different temperatures, 

pressures, and mass fractions of species can be specified in various sub-regions of the model by using 

Init Regions.   

To create an init region, exit the Simulation Parameters dialog, and on the Model menu, choose New 

Init Region….  This opens the Initial Region dialog as shown in Figure 17.4.  Specify the desired 

temperature, pressure, or mass fraction of species to override in the region on the General tab and 

enter the volume parameters on the Geometry tab.  Press OK to create the init region. 
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Figure 17.4. Init Region dialog 

Simulator 

The Simulator tab provides control over the simulator used in FDS.  Refer to the FDS User Manual 

(McGrattan, et al., 2007) for more information on various parameters. 

Radiation 

The Radiation tab provides control over radiation parameters used in FDS.  Refer to the FDS User 

Manual (McGrattan, et al., 2007) for more information on radiation parameters. 

Angled Geometry 

PyroSim allows obstructions and holes to be drawn that are not aligned with the solution mesh needed 

by FDS.  To write the FDS input file, PyroSim must convert these objects to axis-aligned blocks, first. 

PyroSim will either do this automatically when the FDS input file is generated, or this can be done 

manually for individual objects by right-clicking the object and selecting Convert to Blocks…. 

The Angled Geometry tab of the simulation parameters dialog provides default parameters that control 

conversion of obstructions and holes into blocks for the FDS input file as shown in Figure 17.5.1 

                                                           
1
 If objects are converted manually through the right-click menu, a dialog with the same conversion parameters is 

shown to the user that is initialized with the values from the angled geometry tab of the simulation parameters 
dialog. 
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Figure 17.5. Angled Geometry tab of the simulation parameters dialog 

 Conversion Filtering: Controls which objects are converted into blocks. 

o Rasterize only non axis-aligned objects [default]: This prevents objects that are already 

axis-aligned blocks from being processed in the conversion engine.1 

o Rasterize all objects: Forces all obstructions and holes, regardless of shape, to be 

converted to blocks. 

 Grouping: Controls how resulting objects are created after being converted to blocks. This is 

more relevant to manual conversion of objects to blocks. 

o Group blocks into composite objects [default]: For each converted object (such as a 

wall), creates one resulting object that is a composite of all the sub-blocks. 

o Create an object for each block and add to a group: Creates a new PyroSim object for 

each resulting block. These objects are then added to a group representing the original 

object. 

 Block Size: Controls how large resulting blocks may be. See Figure 17.6. 

o Allow resulting blocks to span multiple mesh cells [default]: Resulting adjacent blocks 

with the same properties are merged into one block, vastly reducing the number of 

produced blocks. 

o Force blocks to be on larger than one grid cell thick: Blocks will not be merged.  This 

may create great numbers of blocks that will take additional memory but have the 

advantage of being more easily deleted. 

                                                           
1
 Using this option skips axis-aligned blocks, but it does not check that the boundaries of the skipped objects are 

aligned with mesh cell boundaries. 
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 Thickening: Controls whether objects are allowed to be thin. 

o Allow thin obstructions [default]: Allows objects to become thin as shown in Figure 

17.7.  This may be overridden for obstructions by turning on Thicken in the obstruction 

properties dialog.1 

o Force all obstructions to be thickened: Prevents all obstructions from becoming thin. 

 Merge objects with identical properties [default=true]: Allows blocks to be merged across 

source objects if their resulting blocks have similar properties.  For instance, if this is true and 

two walls are drawn with similar properties, their converted blocks will be merged into the same 

group or composite object. This can further reduce the number of resulting objects. 

o Separate disjoint objects [default=true]:  Prevents objects’ block from being merged if 

their blocks do not touch. 

o Ignore names while merging [default=false]: Controls whether names are considered 

when determining whether objects are “similar.” 

  
Figure 17.6. Merging converted blocks 

   
Figure 17.7. Effect of thickening on converted blocks 

Misc  Tab 

This tab allows some miscellaneous simulation and model properties to be set. 

                                                           
1
 FDS does not allow thin obstructions to have vents attached to them. 
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Figure 17.8. Misc. tab on the simulation parameters dialog 

 Default Surface Type: This specifies the surface to apply to mesh boundaries. 

 Force the Mixture Fraction Model (If Needed): This detects if an output quantity is being used, 

such as by a device,  

Single-thread Execution 
Once you have created a fire model, you can run the simulation from within PyroSim. FDS actions can be 

accessed from either the FDS menu or the main toolbar, as shown in Figure 17.9. To begin a single-

processor simulation, on the FDS menu, click Run FDS... or click  from the main toolbar. NOTE: By 

default, PyroSim will not automatically save the current model to disk unless indicated to do so under 

File->Preferences... under the FDS tab. 

 

Figure 17.9. The FDS Toolbar 

PyroSim will create a sub-directory of the current PyroSim file to store FDS input and results. So for 

instance, if the PyroSim file is named “C:\pyrosim_files\switchgear.psm”, the results will be stored in 

“C:\pyrosim_files\switchgear\ ”. PyroSim will save a copy of the current PyroSim file into this directory, 

as well as the FDS input file, a Smokeview .ini file, and a .ge1 file containing detailed geometry. The input 

files will automatically be named after the PyroSim file. For the switchgear example, the files would be 

“switchgear.fds”, “switchgear.ini”, and “switchgear.ge1”. All result files from FDS will also be stored in 

this directory. 

Next, the FDS Simulation dialog shown in Figure 17.10 is launched. This dialog, which shows FDS 

progress and messages, can be minimized and you can continue using PyroSim (and even run additional 

simulations) while a simulation is running. 
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Figure 17.10. The FDS simulation dialog 

You can save the simulation log at any time by clicking Save Log. This log will be saved as a text file. 

You can also run Smokeview while the simulation is in progress by clicking Run Smokeview. For details 

on how to use Smokeview, please consult the Smokeview User’s Guide. Smokeview will run 

automatically when the simulation is finished. 

Clicking Stop will cause PyroSim to create a .stop file that signals FDS to stop the simulation, but also 

write out a checkpoint file that can be used to resume the simulation later. There is often a significant 

delay between the time when you click the Stop button and when the simulation actually terminates. 

This is because FDS checks for the stop file at the same rate that it updates the progress information. 

To immediately terminate the current simulation, you can click Kill or close the dialog. You will not be 

able to resume the current simulation. 

NOTE: When starting a simulation or exporting an FDS file for some models, the user may receive the 

following message as shown in Figure 17.11: “PyroSim has detected a hole touching a mesh boundary, 

which may cause cutting problems in FDS.  Would you like to slightly expand these types of holes?” 
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Figure 17.11. Expand Boundary Holes dialog 

FDS currently has an issue where it will not fully cut a hole from an obstruction if both the hole and 

obstruction touch a mesh boundary at the same location.  Instead, FDS leaves a thin obstruction along 

the mesh boundary.  Figure 17.12 shows a model in PyroSim that can lead this problem.  In this model, 

both the hole and the obstruction touch the bottom of the mesh, and the hole should cut all the way 

through the mesh.  Figure 17.13 shows this model in FDS where the hole has not been punched all the 

way through the obstruction. 

PyroSim detects potential cases where this might happen and prompts the user with the Expand 

Boundary Holes dialog.  If the user chooses to expand the hole (the Yes option), PyroSim will expand the 

hole to 1/10 of a mesh cell past the mesh boundary for every side of the hole that touches a mesh 

boundary.  This ensures the hole is properly cut all the way through the obstruction as shown in Figure 

17.14.  If the user chooses not to expand these types of holes (the No option), the hole will be written 

exactly as specified and may lead to the thin obstruction problem. 

 

 

Figure 17.12. Hole along a mesh boundary 
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Figure 17.13. Improperly cut hole along mesh boundary in FDS 

 

Figure 17.14. Properly cut hole along mesh boundary in FDS 

Parallel Execution 
PyroSim includes support to launch a parallel simulation using MPI. When running a simulation in 

parallel, all of the computation within each of the meshes can take place independently. Assuming a 

simulation executes in t seconds using only one processor, the best possible performance improvement 
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using n processors and n meshes is a reduction to t/n seconds1. In reality, this is not generally possible 

due to communications overhead and load balancing. 

PyroSim’s support for parallel execution is restricted to a single machine and is only beneficial on 

machines that have dual core or multiple CPUs. 

To launch a parallel simulation in PyroSim, on the FDS menu, click Run FDS Parallel... or click the down 

arrow next to the Run FDS... button ( ) and select Run FDS Parallel.... 

Before running a parallel simulation, you may want to take into account some guidelines: 

• Use at least as many meshes as available processors (or cores). If there are 4 available 

processors and only two meshes, the additional two processors will not be used. 

• Do not overlap meshes. Since information is exchanged between meshes at the edges, it is ideal 

to organize meshes in such a way that they touch, but do not overlap. It is not recommended to 

embed a fine mesh within a coarse mesh in an attempt to improve localized mesh resolution. 

Because information is exchanged at mesh boundaries, the outer mesh will not receive any data 

from the inner mesh. 

• Do not allow a fire source to cross mesh boundaries. When a fire source crosses mesh 

boundaries, it is not possible to maintain the same level of simulation accuracy. 

For a detailed list of suggestions and information about running FDS in parallel, please consult section 

6.3.2 of the FDS Users Guide. 

Cluster Execution 
PyroSim supports the ability to run an FDS simulation on a network cluster using MPI. This has similar 

restrictions to running a parallel simulation, in that each grid is run in a separate process. The cluster 

may be composed of several computers, or nodes, and each node may have any number of processors. 

Before launching a cluster simulation from within PyroSim, the node installer (available from the 

PyroSim website) must be installed on each computer that will participate, including the computer 

running PyroSim if it is to be part of the cluster. Running the node installer will install the MPI service 

and configure it appropriately for use by PyroSim. 

If you have purchased the PyroSim cluster option, you will be able to run the simulation on any number 

of computers. If you have not purchased the cluster option, you will be limited to the computer running 

PyroSim plus one other. 

To launch a cluster simulation within PyroSim, on the FDS menu, click Run FDS Cluster... or click the 

down arrow next to the Run FDS... button ( ) and select Run FDS Cluster.... This will launch the 

Cluster FDS Parameters dialog as shown in Figure 17.15. 

 

                                                           
1
 This is also referred to as a linear performance improvement, or linear speedup. 
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Figure 17.15. The Cluster FDS Parameters dialog 

All nodes in the cluster can be entered in the table, along with the number of processes to launch on 

each node (NOTE: these nodes will be remembered the next time a cluster simulation is run). The 

Assigned Meshes column previews which FDS meshes will run on each computer, which is determined 

by the order of the meshes and the order of the hosts. The FDS File Location must be in a directory that 

is visible to all nodes in the cluster. Click the OK button to begin the simulation. 

All input and output files will be stored in the same directory as the specified FDS file. In addition to the 

standard input files, PyroSim will also copy the appropriate FDS and MPI executables into the FDS file’s 

directory. This ensures that all nodes in the cluster use the same versions of FDS and MPI. 

Resuming a Simulation 
If an FDS simulation has been gracefully stopped by pressing the Stop button in the simulation dialog, it 

can later be resumed. To do so, on the FDS menu, click Resume Simulation.... This will cause an 

additional RESTART flag to be written to the FDS input file. When FDS detects this flag it will 

automatically attempt to reload the previous execution state from the hard disk and resume where it 

left off. If FDS is unable to load the previous execution state, it will exit with an error.
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Chapter 18. Post-Processing  
PyroSim supports post-processing in two ways: 

• Launching of Smokeview from within PyroSim, and 

• Time history plots of output data. 

Launching Smokeview  
Smokeview is a post-processor for FDS supplied by NIST. It allows the user to view the FDS model along 

with results in 3D. The user can view animated smoke, slices, Plot3D, and various other output 

quantities. 

By default, if you run FDS from within PyroSim, Smokeview will be launched at the end of the FDS run. 

Alternately, you can click  on the FDS toolbar to launch the most recent results. You may also run 

Smokeview at any time by going to the FDS menu and selecting Run Smokeview.... This will prompt you 

to choose a Smokeview file to open. 

Time History Results  
Time history results are saved for heat detectors, thermocouples, and other fire output. After running an 

FDS simulation, the most recent plots can be viewed by clicking  on the FDS toolbar. This will show a 

plot of thermal results. Device and control results may also be viewed by by clicking the down-arrow and 

selecting the desired plot. Additional plots may be shown by going to the FDS menu and choosing Plot 

Time History Results.... A typical heat detector plot is shown in Figure 18.1. The user can export the 

image to a file. 

 

Figure 18.1. Time History Results 
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Archiving Results 
After running a simulation, the results may be archived along with the FDS and PyroSim input files. To do 

so, on the FDS menu, click Archive FDS Results.... This will show the Archive FDS Results dialog as 

shown in Figure 18.2. 

 

Figure 18.2. Archive FDS Results dialog 

The Archive name identifies the archive for later retrieval. The default name contains the name of the 

model along with a date stamp. If Retain current results is checked, the current results will remain in 

place and a copy will be made for the archive. If unchecked, the current results will be deleted. If 

Compress to a ZIP file is checked, the archive will be stored in a compressed ZIP file. If unchecked, the 

archive will be stored as a duplicate folder of the current results. Press OK to create the archive. The 

archive will be stored in the directory of the current PyroSim file. 

NOTE: In order for PyroSim to remember the archive for later retrieval, the PyroSim file must be saved 

after creating the archive. 

Restoring Archived Results 
Once results have been archived, they can be later restored. To do so, on the FDS menu, click Restore 

FDS Results.... This will show the Restore Archived Results dialog as shown in Figure 18.3. 
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Figure 18.3. Restore Archived Results dialog 

The Destination directory indicates the folder where the results will be restored. By default, this is the 

results directory of current PyroSim file. If Retain selected archive is checked, the selected archive will 

be kept on disk. If it is unchecked, the selected archive will be deleted. The table of Available Archives 

shows a record of all archives made under the current PyroSim file. Select one of these archives and 

then press the OK button to restore the archive.
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Chapter 19. Managing Data Libraries 
Libraries of material, or other model data, can reduce errors and speed the creation of new models. The 

user can import data from the library into a new model. This section describes how to manage PyroSim 

libraries. 

Create and Manage Your Own Libraries  
You can create and manage your own libraries for data that you commonly use. A library is a single file 

that can contain several categories of objects, such as Materials, Gas-phase Reactions, and Surfaces. To 

manage your library: 

1. On the Model menu, click Edit Libraries. 

2. Select the Category that you want to manage and move selected items from the Current Model 

into the Library, Figure 19.1. 

3. Click Save Current Library and save the library in a location and with a name that you can access 

in the future. 

4. Close the PyroSim Libraries dialog. 

 

Figure 19.1. Creating a library of materials 

After you have saved your library, you can load it into a new model and copy data from the library to 

your model. 

Use the Library Provided with PyroSim 
PyroSim includes a library of reaction and material data that has been gathered from the verification 

analyses provided with FDS. Each of these reactions and materials has a reference in the Description 

that documents the source of the data. This library is presently quite limited. NIST is supporting the 
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development of an engineering guide that will document the standard test methods used to obtain 

material properties. 

To import data from the PyroSim database: 

1. On the Model menu, click Edit Libraries.... 

2. Click Load Library and open the property library.fds file that is found in the 

C:\Program Files\PyroSim 2008\samples folder. 

3. In the Category box, select Gas-phase Reactions and copy appropriate reactions into your 

model. 

4. In the Category box, select Materials and copy the appropriate materials into your model. 

5. Close the PyroSim Libraries dialog. 

Import a Material or Reaction from the FDS 4 Database  
First, a caution. Version 4 of FDS provided a database that included several common materials and 

reactions. In version 5, the FDS developers made a conscious choice to remove material and reaction 

data. Many of the materials in FDS 4 were simply examples, and they were worried that users were 

applying them without using their own test or lab data as validation. In this section, we describe how 

to import the FDS 4 database, however, it is your responsibility to verify that this data is correct and 

applicable to your simulation. 

You can convert the old FDS 4 materials and reactions for use in PyroSim 2007. To import FDS 4 data: 

1. On the File menu, click Import and select FDS File.... 

2. In the Open dialog, browse to Program Files/PyroSim 2007/fds folder and open the 

database4.data file. 

3. You will receive conversion warning messages depending on what is converted and what 

properties are defined. Because of the change in material and reaction models between FDS 4 

and FDS 5, you should review these carefully and edit the imported data appropriately for use 

with FDS 5. You can save the warnings to a file for future reference. 

4. Click OK to close the File Conversion Warnings dialog. 

5. The imported materials and reactions are now available for use in PyroSim 2007. It is the user’s 

responsibility to verify these values. 
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Chapter 20. Advanced FDS Parameters  
PyroSim tries to support FDS completely, but there are some more obscure features that might not be 

found in the PyroSim user interface. For these items, PyroSim provides additional mechanisms to allow 

these features through the Additional Records section of the Record View and the Advanced tab of 

some dialogs. 

Additional Records Section  
There are times when PyroSim does not support an entire record. In this case, the record can be entered 

into the Additional Records Section of the Record View as shown in Figure 20.1. 

 

Figure 20.1. Additional Records Section 

When PyroSim write the FDS input file, it copies the contents of the Additional Records Section exactly 

at the beginning of the FDS file. 

Because PyroSim performs no validation on text in this view, it is up to the user to ensure that the 

statements are well-formed FDS statements and that they do not conflict with any records generated by 

PyroSim. In addition, none of the records written in this section can be referenced by other PyroSim 

objects. For instance, if a SURF record is entered in this section, it cannot be referenced by an 

obstruction in the PyroSim user interface. The only way to do so would be to write the obstruction in the 

Additional Records Section as well. 

Some records, such as MISC, RADI, and others that occur once in the FDS input file can be entered in the 

Additional Records Section even if PyroSim has generated the record already. For instance, if PyroSim 

generates the record, “&MISC TMPA=30.0/”, you can still enter another entry for MISC in the Additional 

Records Section, such as “&MISC P_INF=2.0E5/”. FDS will merge these MISC records together to form 

“&MISC P_INF=2.0E5, TMPA=30.0/”. 
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Advanced Parameters  
Sometimes PyroSim may support a record but may not support it completely. For many of these records, 

including SURF, REAC, MATL, PART, TIME, DUMP, RADI, and MISC, PyroSim provides a way to enter 

additional fields. For Surfaces, Materials, Reactions, and Particles, there is an Advanced tab in the 

properties dialog where these additional fields may be entered, as shown in Figure 20.2. To enter 

additional fields for TIME, DUMP, RADI, and MISC, on the FDS menu choose Simulation Parameters..., 

then choose the Misc. tab. 

 

Figure 20.2. Additional Fields 

When entering additional fields, you must specify the field name and the field value. These additional 

fields will then be appended to the FDS record generated by PyroSim. As in the Additional Records 

Section, PyroSim will write these fields to the file exactly as entered in the table, so care must be taken 

by the user to make sure they are correct.
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Chapter 21. Troubleshooting  

Licensing/Registration Problems    
If you experience trouble registering PyroSim, please contact <support@thunderheadeng.com>. 

Video Display Problems      
PyroSim utilizes many advanced graphics card features in order to provide accelerated display of models 

in three dimensions. If you have problems with display, such as corruption of the image when you move 

the mouse, go to File->Preferences and turn off the fast hardware drawing options. This will disable the 

image caching and force PyroSim to always re-render the model. This should correct any display 

problems at the expense of speed. 

You can also turn off graphics acceleration by starting PyroSim in Safe Mode. Select Run, All Programs, 

PyroSim, and then PyroSim (Safe Mode). 

If you encounter this problem, please let us know the make/model of your video card and what video 

driver you are using. That will help us improve the faster version to work on more computers. 

Memory for Large Models      
When running large models, it is possible that an out of memory error will be encountered. If this occurs, 

you can increase the default Java heap size. In our experience, the maximum size can be specified to 

approximately 70% of physical memory. By default, PyroSim will specify a java heap size of 50% of 

physical memory. 

To specify the memory, you can either run from a command line or change the Start Menu shortcut 

properties. To run from a command line, open a command window and then go to the PyroSim 

installation directory (usually C:\Program Files\PyroSim). Execute PyroSim on the command 

line using the -JXmx argument. In this argument, the J specifies that the command will be passed 

along to the Java VM, not PyroSim. For example, pyrosim -JXmx1200m will request 1200 MB of 

memory. 

To edit the PyroSim shortcut properties, right-click on the PyroSim icon, select the Shortcut tab, and 

then edit the Target by adding a space and -JXmx1200 to the end of the Target. A typical Target will 

then read ”C:\Program Files\PyroSim\pyrosim.exe” -JXmx500m. 

MPI Problems   
PyroSim Requires a Password to Run Parallel 

MPI processes communicate using network protocols that are disabled by default for accounts without 

passwords. In order to work, MPI must have access to a password-protected account. Users without 

passwords can overcome this problem in a couple ways: 

• Set a password for the account. 
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• Instruct MPI to authenticate using an alternate account. 

To instruct MPI to authenticate using an alternate account (e.g. set to mpi_user on a computer named 

aurora), you must issue a command using the console. 

Microsoft Windows [Version 6.0.6002] 

Copyright (c) 2006 Microsoft Corporation.  All rights reserved. 

 

C:\>cd “\Program Files\PyroSim 2010\fds” 

 

C:\Program Files\PyroSim 2010\fds>mpiexec -remove 

Account and password information removed from the Registry. 

 

C:\Program Files\PyroSim 2010\fds>mpiexec -register 

account (domain\ user) [aurora\thornton]: aurora\mpi_user 

password:  

confirm password:  

Password encrypted into the Registry.     

To verify that MPI will function with the account information (32-

bit): 

C:\Program Files\PyroSim 2010\fds>mpiexec -validate -port 52400 

SUCCESS     

To verify that MPI will function with the account information (64-

bit): 

C:\Program Files\PyroSim 2010\fds>mpiexec -validate -port 52500 

SUCCESS     

When trying to Run Parallel, PyroSim Repeatedly Requests a Password 

PyroSim attempts to validate the MPI configuration prior to running the simulation. If this validation fails, 

PyroSim assumes it was because of a password mismatch. If you know this is not the case (e.g. you know 

you entered your password correctly), PyroSim may be responding incorrectly to a different error. To 

diagnose this error, please run PyroSim in safe mode. The error output should appear at the bottom of 

the console window. Forward this text to <support@thunderheadeng.com> and the support staff 

will help resolve the problem. 

When Trying to Run Parallel, FDS Completes Immediately with No Output 

This indicates that MPI started successfully, but the FDS executable (fds5_mpi) failed to run. To gather 

additional information about this error, you must run the MPI executable manually from the command 

prompt and observe the error output. To run the MPI executable manually, open a console window and 

issue the following commands: 

Microsoft Windows [Version 6.0.6002] 

Copyright (c) 2006 Microsoft Corporation.  All rights reserved. 
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C:\>cd “\Program Files\PyroSim 2010\fds” 

 

C:\Program Files\PyroSim 2010\fds>fds5_mpi     

The subsequent output should resemble the start of a successful FDS run; however, in this case it will 

probably contain error output. Copy this error output and email 

<support@thunderheadeng.com>, the support staff will help resolve the problem. 

Contacting Technical Support 
The PyroSim software is available for download at: http://www.thunderheadeng.com. The same site 

provides PyroSim user manuals and example problems. Please follow the examples to become familiar 

with the software. 

Questions and suggestions should be sent to <support@thunderheadeng.com> or by phone to 

+1.785.770.8511. 

Mail should be sent to: 

Thunderhead Engineering 

403 Poyntz Ave. Suite B 

Manhattan, KS 66502-6081 

USA

http://www.thunderheadeng.com/
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Appendix A. Opening FDS v4 and PyroSim v2006 Files  
Due to the differences between versions 4 and 5 of FDS, it is not always possible to automatically 

convert legacy FDS input files and PyroSim 2006 PSM files to the new version. However, many 

conversions are possible and in many cases PyroSim can completely convert old input files to the new 

format. 

PyroSim will begin the conversion process as a result of either of two actions: (1) opening a PSM file 

saved with a version of PyroSim designed to work with version 4 of FDS, and (2) importing an FDS input 

file designed to work with version 4 of FDS. 

In many cases, PyroSim 2007 can import records intended for version 4 of FDS that PyroSim 2006 could 

not. This is because PyroSim 2007 supports a broader range of FDS features than the previous version. 

Examples of previously unsupported version 4 features that can now be imported include solid-phase 

thermocouples and extra species. 

The process for converting PSM files and FDS input files is identical. PyroSim first loads the data into a 

form designed to work with version 4 of FDS, then applies conversion logic to produce the 

corresponding data structures designed to work with version 5 of FDS. When PyroSim encounters a 

record that cannot be automatically converted, a warning message is generated. Each warning contains 

information about the source of the problematic record and the action taken. Some records are simply 

dropped and others are converted to default values. If a record is encountered that cannot be converted, 

but contained only default values and would not have affected the simulation, that record is dropped 

without issuing a warning. 

Great care was taken to ensure that PyroSim generates these warnings whenever they contain 

important information, but not so often that they distract from important issues. When in question, 

PyroSim will err on the side of caution and generate a warning message. An example of this warning 

dialog is shown in Figure A.1. If no warning dialog appears, PyroSim was able to convert the input file 

without encountering any compatibility issues. 
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Figure A.1. Example import warnings 

In most cases, the following records can be converted with no additional input: 

• Geometry Data (walls, holes, triangles, etc...) 

• Textures 

• Mesh 

• Floors 

• Particles1 

• Smoke Detectors 

• Thermocouples 

• Heat Detectors 

• Boundary Quantity Output 

• Plot3D Data 

• Isosurfaces 

• Slices 

• Unsupported Records2
 

Global Simulation Parameters 
The following items that can be set in the Simulation Parameters dialog of PyroSim 2006 are not 

supported in PyroSim 2007 and will be dropped. 

• Under the Simulator tab, Incompressible Calculation (excludes heat) 

• Under the Environment tab, External Temperature 

                                                           
1
 PyroSim 2006 did not properly support initial droplets or particle clouds.  In PyroSim 2007 particle clouds are 

supported and existing particles with initial droplets specified will now be handled correctly. 
2
 The unsupported records are copied verbatim from your previous version.  Even though some of these records 

may now be supported, PyroSim will not perform any automated handling. 
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• Under the Particles tab, Droplet Insert Interval 

• Under the Particles tab, Max Particles per Second 

All other simulation parameters will be converted to PyroSim 2007 without warnings. 

Note 

In PyroSim 2007 it is possible to specify both the particle insertion interval and the particle insertion rate 

on a per particle basis. These options are available in the Edit Particles dialog, in the Injection tab. 

PyroSim does not automatically apply the global data to these fields. 

Sprinklers and Pipes 
All correctly specified sprinkler parameters are converted without warnings. If a sprinkler has been 

assigned a massless particle, however, that sprinkler will be assigned a particle with parameters from 

the make file, and a warning will be issued. 

For FDS 4 sprinkler make files, PyroSim has a robust built-in parser that can handle both simple and 

complex spray patterns. The only requirement is that referenced make files must exist in the fds folder 

in the PyroSim install directory. PyroSim 2007 ships with the make files provided by NIST for FDS 4. If a 

file uses another make file, place it in this directory before importing or opening the file. 

If there is a dry pipe delay greater than zero, PyroSim 2007 will create a single dry pipe with that delay 

and attach it to all the sprinklers in the model. Note, however, that in PyroSim 2007 the water pressure 

is specified per sprinkler rather than per pipe. Because of this, PyroSim will not convert the dry pipe 

pressure specified in the pipe record, and a warning will be issued. 

Reactions 
To convert reaction data into a form useable by version 5 of FDS, PyroSim 2007 must reverse-engineer 

the fuel molecule composition based on stoichiometric coefficients. To accomplish this, PyroSim uses 

the equations given in section 4.4.2 of the users guide for version 4 of FDS. The result is then checked to 

ensure that the total molecular weight is the same as the specified molecular weight. If this check 

succeeds, no warning will be issued. If the test fails, PyroSim will issue a “Converted stoichiometry” 

warning and you must manually update reaction data to ensure accurate simulation results. 

Surfaces 
Some surface properties are converted with no additional input or warnings, including surface names, 

colors, and textures. The different surface types, however, undergo more complicated conversions. The 

following describes how PyroSim 2006 surface types are converted to Surfaces and Materials in PyroSim 

2007: 

• Inert and Adiabatic - converted directly. 

• Burner Fire - converted to a Burner Surface. 

• Fan/Wind - converted to a Supply surface if the air flow is negative, an Exhaust surface, 

otherwise. 

• Flammable Solid of Fixed Temperature or Heat Flux - converted to a Heater/Cooler surface. 
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• Thermally Thick/Thin Flammable Solid - converted to a Layered Surface with one single-step 

reacting Material. 

• Flammable Solid (Constant HRR) of Fixed Temperature or Heat Flux - converted to a burner. 

• Thermally Thick/Thin Flammable Solid (Constant HRR) - converted to a Layered Surface with one 

non-reacting Material. The reaction is controlled at the surface. 

• Non-Flammable Solid of Fixed Temperature or Heat Flux - converted to a Heater/Cooler. 

• Thermally Thick/Thin Non-Flammable Solid - converted to a Layered Surface with one non-

reacting Material. 

• Liquid Fuel - converted to a Layered Surface with one Liquid Fuel Material. 

• Charring Fuel - converted to a Layered Surface with one layer. The layer is composed of a water 

and a virgin material. The virgin material undergoes one reaction where half of it is converted to 

fuel and the other half is converted to the charring material specified in the original surface. This 

ratio may need to be adjusted after conversion. 

• Liquid Thermoplastic - converted to a Layered Surface with one Liquid Fuel Material. 

• Charring Thermoplastic - converted to a Layered Surface with one single-step reacting Material. 

Thermally Thin Surfaces 
Unlike PyroSim 2006, PyroSim 2007 requires that every layered surface specify a thickness (Delta) for 

each layer and that materials specify density (Rho), specific heat, and conductivity (C). In PyroSim 2006, 

there were a number of ways for thermally thin surfaces to either specify or omit these parameters. 

These surfaces allowed any one or more of C, Delta, and Rho to be specified in addition to C*Delta*Rho. 

PyroSim 2007 will make a best-effort calculation of missing parameters. For instance, if C*Delta*Rho is 

specified along with two of the parameters, the third will be calculated; however, if more than one 

parameter is missing, PyroSim will use defaults for up to two of the parameters and calculate the third 

missing one. The default thickness for thermally thin surfaces is set to 1mm. In all cases where a default 

number has been assumed due to a missing parameter, a warning will be shown for the parameter. 

Where is the Surface Database? 
PyroSim 2007 does not currently ship with a surface database, but users can still make their own. In fact, 

many different objects can now be put into a database including materials and surfaces, extra species, 

reactions, particles, and several more. As common surface descriptions and other of these object 

properties become available from reliable sources in a format supported by version 5 of FDS, PyroSim 

will again ship with a pre-filled database.
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